Workshare Compare 10

User Guide
# Table of Contents

Chapter 1: Introducing Workshare Compare ................................................................. 9

What is Workshare Compare? ...................................................................................... 10

Workshare Compare Functionality ................................................................................ 11

What can Compare do? ................................................................................................. 11

See the changes ............................................................................................................. 11

Understand the changes .............................................................................................. 12

Implement the changes ............................................................................................... 12

File share and sync ...................................................................................................... 12

DMS/CRM integration ................................................................................................. 13

Accessing Workshare Compare ................................................................................... 14

Workshare ribbon ........................................................................................................ 15

Enabling Workshare Compare functionality ............................................................... 16

Licensing ....................................................................................................................... 17

Chapter 2: Comparing Documents .............................................................................. 19

Overview - Comparing Documents ............................................................................. 20

PDF comparison ........................................................................................................... 21

Performing Comparisons ............................................................................................ 21

Launching Workshare Compare from Microsoft Word ................................................. 22

Launching Workshare Compare using right-click options ........................................... 22

Launching Workshare Compare from email ............................................................... 23

Launching Workshare Compare from your desktop ..................................................... 24

Comparing Selected Content ..................................................................................... 27

Ensuring Successful Comparisons ............................................................................. 28

Auto retry mode .......................................................................................................... 28

Failsafe mode ............................................................................................................... 29

Workshare Compare Main Window ............................................................................. 30

Moving and placing windows ....................................................................................... 31
Saving redlines................................................................. 56
Saving redlines to Workshare online ................................ 59
Sharing redlines to Workshare online................................. 62
Sending by email.............................................................. 64
Printing redlines .............................................................. 66
Converting redline to PDF ................................................. 68

Chapter 3: Comparing Presentations ............................................. 72
Introducing Compare for PowerPoint ........................................ 73
What is compared? ............................................................ 73
Comparing Presentations ..................................................... 73
Launching PowerPoint comparisons from Microsoft PowerPoint .... 74
Launching PowerPoint comparisons using right-click options .......... 74
Launching PowerPoint comparisons from email ........................ 75
Launching PowerPoint comparisons from your desktop ............... 76
Workshare Compare for PowerPoint from the command line .......... 78

Workshare Compare for PowerPoint Main Window ......................... 80
File menu ......................................................................... 81
Quick access toolbar .......................................................... 81
Home tab ......................................................................... 81
More tab ........................................................................... 83
Slide Selector area ........................................................... 83
Slide View area ................................................................ 84
Change Summary area ....................................................... 85
Working with Comparisons ................................................... 86
Navigating changes ................................................................ 86
Navigating between slides ................................................... 86
Navigating between changes ............................................... 87
Searching changes ................................................................ 88
Swapping the source files ................................................... 89
Saving comparisons ........................................................... 89
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Opening saved Workshare Compare for PowerPoint files</td>
<td>89</td>
</tr>
<tr>
<td>Creating comparison reports</td>
<td>90</td>
</tr>
<tr>
<td>Printing comparison reports</td>
<td>91</td>
</tr>
<tr>
<td>Chapter 4: Comparing Spreadsheets</td>
<td>93</td>
</tr>
<tr>
<td>Introducing Compare for Excel</td>
<td>94</td>
</tr>
<tr>
<td>What is compared?</td>
<td>94</td>
</tr>
<tr>
<td>Comparing Spreadsheets</td>
<td>94</td>
</tr>
<tr>
<td>Launching Excel comparisons using right-click options</td>
<td>95</td>
</tr>
<tr>
<td>Launching Excel comparisons from email</td>
<td>95</td>
</tr>
<tr>
<td>Launching Excel comparisons from your desktop</td>
<td>96</td>
</tr>
<tr>
<td>Password-protected spreadsheets</td>
<td>99</td>
</tr>
<tr>
<td>Workshare Compare for Excel Main Window</td>
<td>100</td>
</tr>
<tr>
<td>File menu</td>
<td>100</td>
</tr>
<tr>
<td>Home tab</td>
<td>101</td>
</tr>
<tr>
<td>Comparison area</td>
<td>102</td>
</tr>
<tr>
<td>Change details panel</td>
<td>103</td>
</tr>
<tr>
<td>Understanding Changes</td>
<td>103</td>
</tr>
<tr>
<td>Source formatting</td>
<td>103</td>
</tr>
<tr>
<td>Change types</td>
<td>104</td>
</tr>
<tr>
<td>Direct and indirect changes</td>
<td>104</td>
</tr>
<tr>
<td>Change type filters</td>
<td>105</td>
</tr>
<tr>
<td>Changes to a cell</td>
<td>107</td>
</tr>
<tr>
<td>Navigate between changed cells</td>
<td>107</td>
</tr>
<tr>
<td>Priorities for highlighting direct and indirect changes</td>
<td>108</td>
</tr>
<tr>
<td>Priorities for highlighting inserted and deleted cells</td>
<td>108</td>
</tr>
<tr>
<td>Working with Comparisons</td>
<td>109</td>
</tr>
<tr>
<td>Swapping the source files</td>
<td>109</td>
</tr>
<tr>
<td>Saving comparisons</td>
<td>109</td>
</tr>
<tr>
<td>Chapter 5: Working Online</td>
<td>112</td>
</tr>
<tr>
<td>Overview</td>
<td>113</td>
</tr>
</tbody>
</table>
Syncing Local Files................................................................. 113
What is the desktop app?............................................................. 114
  Launching the desktop app for the first time................................. 114
Workshare sync folder................................................................ 115
System tray icon....................................................................... 116
Adding files to Workshare via the sync folder............................... 117
Files won’t sync from here......................................................... 118
Restoring deleted files................................................................ 119
File synchronization.................................................................. 121
  Selective synchronization.......................................................... 122
Sync progress.......................................................................... 123
  Synchronization conflict........................................................ 124
Collaborating in Workshare....................................................... 126
Getting Content Online............................................................ 127
  Right-click sharing................................................................ 127
From open Office documents..................................................... 128
  Saving to My Files............................................................... 129
Sharing to a Workshare group................................................... 131
  Monitoring shared files....................................................... 132
Chapter 6: Advanced PDF Functionality..................................... 136
  Converting PDF Files to Word Format....................................... 137
Chapter 7: Configuring Workshare............................................. 139
  Introducing the Workshare Configuration Manager..................... 140
    Administrator Mode and User Mode........................................... 140
  Accessing the Workshare Configuration Manager....................... 140
    Searching parameters........................................................ 141
  Setting Parameters................................................................ 142
Appendix A. Configuring Rendering Sets........................................ 144
  Introducing Rendering Sets................................................... 145
    Where are rendering sets stored?........................................ 145
Applying rendering sets ................................................................. 146
Accessing the Rendering Sets Manager ........................................ 146
From the Workshare Configuration Manager .................................. 146
Before running a comparison ...................................................... 147
After running a comparison ....................................................... 148
Customizing Rendering Sets .......................................................... 149
  Modifying existing rendering sets ............................................. 149
  Creating new rendering sets .................................................. 149
  Deleting rendering sets ....................................................... 150
Rendering Set Parameters .......................................................... 150
  Comparison Options ........................................................... 151
  Redline Options ..................................................................... 154
    Readability ........................................................................... 156
  Redline Rendering ............................................................... 158
  Inserted Text ........................................................................... 158
  Deleted Text ........................................................................... 159
  Moved Text ............................................................................ 160
  Change Numbering .............................................................. 162
  Font Changes .......................................................................... 162
  Style Changed Text .................................................................. 163
  Table Changes ......................................................................... 164
Appendix B. Configuring Comparison Themes ....................................... 166
  Introducing Comparison Themes ............................................ 167
  Applying Comparison Themes ............................................... 167
  Customizing Comparison Themes ........................................... 168
    Creating new comparison themes ...................................... 169
    Modifying existing comparison themes ............................... 169
  Comparison Theme Parameters .................................................. 170
    Comparison .......................................................................... 171
    Insertions ............................................................................. 172
Deletions ................................................................. 173
Moves ................................................................. 174
Property Changes .............................................................. 175
Font Changes .............................................................. 176
Sensitivity ............................................................... 177
Appendix C. Configuring Workshare Desktop App ............................................. 179
Configuring the Workshare Desktop App ......................................................... 179
Chapter 1: Introducing Workshare Compare

This chapter introduces Workshare Compare, providing an overview of how it works as well as a summary of the key features and benefits. It includes the following sections:

- **What is Workshare Compare?**, page 10, introduces Workshare Compare.
- **Workshare Compare Functionality**, page 11, describes the different areas of functionality of Compare.
- **Accessing Compare Functionality**, page 14, describes how to access Compare functionality after install.
- **Licensing**, page 16, describes how to license Compare after install.
What is Workshare Compare?

Workshare Compare reimagines multi-party review and collaboration and ensures the safe and accurate exchange of information, enabling the collaborative evolution of high value business documents.

Workshare Compare is a desktop application that automates managing changes to business documents.

Key features of Workshare Compare include:

- Comparison of Word, PowerPoint, Excel and PDF files, including image-based PDF files
- Comparison of selected pieces of content, such as a single paragraph or clause
- Ability to accept/reject changes in a comparison and then create new documents
- Advanced comparison features including one-to-many comparisons (Word and PDF files), version comparisons, and access from within Office and Document Management Systems
- Access to comparison functionality from within Outlook as well as right-click access from within individual emails
- Conversion from PDF to DOC format for local files and from within the DMS/CRM
- Options to save and share Office documents to Workshare online
- Access and visibility into online collaborative workspaces directly from Office
- Secure file sharing from all devices and browsers with metadata removal and end-to-end encryption
- ECM/DMS and OCR integration with desktop comparison features
- Centralized user account management and control
- Complete access to Workshare online functionality to share and collaborate on documents, including setting folder access and permissions, positional commenting and reviewer communications with presence indicators
- Desktop sync app to synchronize your online content to your local desktop

Note: Workshare Compare can be installed without Microsoft Office integration. In this case, the comparison functionality is only available from the Workshare comparison applications.
Introducing Workshare Compare

Workshare Compare Functionality

Workshare Compare provides sophisticated functionality that is convenient and accessible, enabling users to move smoothly between tasks and work rapidly to manage changes. Workshare Compare assists you throughout the complete document lifecycle – from document assembly, review, verification and security. Workshare Compare has also made key functionality of the DMS available, for example, enabling the comparison of DMS versions.

Workshare Compare may include the Connect product to extend its functionality to Workshare online.

What can Compare do?

Workshare Compare reinvents multi-party review by helping users understand, communicate and implement changes more quickly and accurately. Compare shows precise changes between versions of Word, PDF, PowerPoint and Excel files including DMS files and versions. The DeltaView redline sets the standard for an easy-to-read, accurate view of changes between document versions. Compare’s advanced comparison engine performs comparisons accurately and seamlessly enabling users to quickly compare even the most difficult and complex documents, presentations and spreadsheets.

See the changes

With Microsoft Word and PDF files, users can perform one-to-one and one-to many comparisons and see accurate DeltaView redlines in individual tabs. Compare compares both regular text-based PDF files and image-based PDF files that originate from scanned documents, automatically applying OCR (Optical Character Recognition) processing to translate the images of typewritten text into editable text. Compare provides access to files and version information stored in a DMS/CRM or SharePoint and users can browse for files to compare as well as save comparisons into the DMS/CRM or SharePoint.

Users can launch Compare from the environment that suits them:

- Launch a comparison of an attachment directly from an email message
- Launch a comparison from within Word, Excel or PowerPoint
- Launch a comparison from within a DMS/CRM or SharePoint

Selective Compare enables the user to copy snippets of text from anywhere and run a comparison in Workshare. This is much faster and more focused than comparing an entire document.
Understand the changes

Compare provides an intuitive interface that enables users to navigate easily between changes. Category View divides changes according to type, for example, numbering changes, punctuation changes or matching changes, enabling users to quickly focus on the changes that are important to them.

Implement the changes

When comparing Word and PDF files, Compare includes the ability to accept and reject changes (individually or as a group) and create a new Word document that includes all the changes.

File share and sync

Workshare’s online services provide a secure file sharing and online collaboration tool that enables users to store, share, and collaborate on content. There are several ways of interacting with the online services offered by Workshare, either online through a web browser or using special apps. The Workshare desktop app is the app for use on PCs and it is installed as part of the Compare installation when you select the file share & sync option.

*Note: Workshare’s mobile apps are apps designed for use on smartphones and tablets that provide access to documents in Workshare online while on the move.*

Users can sync documents safely across all their devices automatically updating content between Workshare online and their desktop and mobile devices.

With the Groups functionality, users can easily organize and manage files and projects, ensuring the correct users and permissions are set up for a group. Tools for commenting, annotating, and file comparison are available to support all stages of document evolution. Users receive updates when files in particular groups are being accessed, commented on, or modified by other reviewers, so ideas and conversations are never missed. Once new file versions are uploaded, users can compare old and new versions to see at a glance what has changed.

Users can access, review, and collaborate on files from any device, supporting company-wide mobility initiatives. Users can also select files to save for offline access, enabling users to work on files without Internet access. Once the device is connected again, all updates are synced back as a new version.

IT security controls are available at an account level, allowing data governance regulations to be met, and reduce the risk of accidental data loss. For added security, organizations can choose where their corporate data is stored (public cloud, custom public cloud, or hybrid). Finally, Workshare online can be integrated with existing DMS to securely mobilize content, and get the most out of IT system investments.
Introducing Workshare Compare

With Compare, users can save and share redlines or Office files (directly from Compare or Office) to Workshare online so they can access them on their other devices and on the move. Once shared, users can see their shared document, spreadsheet or presentation come alive and understand who’s reviewing it online - directly from Word, Excel or PowerPoint.

DMS/CRM integration

DMS/CRM integration

Workshare Compare can integrate with your DMS or CRM as well as SharePoint to provide comparison and other functionality.

Note: To integrate with a DMS/CRM or SharePoint, Workshare Compare must be installed with the relevant integration selected and additional details may need to be configured in the Workshare Configuration Manager. Refer to your system administrator for further information.

The specific functionality available with each DMS/CRM integration is detailed in the table below:

Note: The comparison functionality relates to all file types – Word, PDF, Excel and PowerPoint – unless specified.

<table>
<thead>
<tr>
<th>Functionality</th>
<th>iManage</th>
<th>Net Documents</th>
<th>OpenText</th>
<th>Worldox</th>
<th>SharePoint</th>
</tr>
</thead>
<tbody>
<tr>
<td>From Workshare comparison application, browse to DMS</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>From Workshare comparison application, save to DMS</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Right-click from within DMS, launch Workshare comparison</td>
<td>✓ 1</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>From Connect desktop app, browse to DMS to add files to Workshare</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>
1 The right-click option is available in iManage FileSite/DeskSite clients. If you’re using the iManage Work 10 web client, you can access Workshare comparison for Word and PDF files from the kebab menu but you will need the Workshare IManage Integration Server installed. See Installing WIIS in the knowledge base for more information.

2 The Workshare options are available via Send to application functionality in NetDocuments.

3 In Wordox, the Workshare comparison is also available using the Compare Files button in the toolbar.

# Accessing Workshare Compare

Workshare Compare can integrate with Microsoft Word, Excel, PowerPoint and Outlook so that comparison is available from within these Office applications. Additionally, Workshare Compare and Workshare Compare for PowerPoint are available as standalone applications.

After you have installed Compare, the Workshare tab is added to the ribbon in your Microsoft Office applications - Word, Excel and PowerPoint. The addition of Compare does not affect the standard functionality of Word, Excel or PowerPoint. You can operate these applications as usual and access the Compare functionality as required.

Workshare Compare functionality can also be accessed in the following ways:

- Right-click closed Word or PowerPoint documents and select **Compare with Workshare**.
- Right-click closed PDF documents and select **Compare with Workshare** or **Open in Word with Workshare**.
- Right-click attachments in Outlook and select **Compare with Workshare**.
- Click **Compare** or **Selective Compare** in the Workshare ribbon in Outlook.
- Right-click any file and select **Workshare/Share to Group**.

The Workshare Compare standalone application can also be accessed from the Start menu or by double-clicking the Workshare Compare icon on the desktop.

The Workshare Compare for PowerPoint standalone application can also be accessed from the Start menu or by double-clicking the Workshare Compare for PowerPoint icon on the desktop.
The Workshare Compare for Excel standalone application can also be accessed from the Start menu or by double-clicking the Workshare Compare for Excel icon on the desktop.

**Note:** Workshare Compare can be installed without Microsoft Office integration. In this case, the Workshare ribbon is not available. The Workshare comparison functionality is only available from the Workshare standalone applications.

### Workshare ribbon

In Office applications, the Workshare ribbon is included as follows:

<table>
<thead>
<tr>
<th>Group</th>
<th>Item</th>
<th>Description</th>
<th>Available</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Compare</strong></td>
<td><strong>Compare</strong></td>
<td>Enables you to compare a Word or PowerPoint file with a previous version of the same file or with another file. Refer to Overview - Comparing Documents and Introducing Compare for PowerPoint for further information.</td>
<td>Word, PowerPoint, Outlook</td>
</tr>
<tr>
<td></td>
<td><strong>Selective Compare</strong></td>
<td>Enables you to compare a snippet of text with another snippet of text. Refer to Comparing Selected Content for further information.</td>
<td>Word, Outlook</td>
</tr>
<tr>
<td><strong>Sharing</strong></td>
<td><strong>Toggle Panel</strong></td>
<td>Displays/hides the Workshare Connect panel in your Office window where you can see what’s happening with a collaboration in real-time. Refer to Getting Content Online for further information.</td>
<td>Word, Excel, PowerPoint</td>
</tr>
<tr>
<td></td>
<td><strong>Save to My Files</strong></td>
<td>Enables you to save documents to Workshare online so they will be accessible to you online at all times. Refer to Saving to My Files for further information.</td>
<td>Word, Excel, PowerPoint</td>
</tr>
</tbody>
</table>
Enabling Workshare Compare functionality

To ensure Workshare Compare functionality is *fully* enabled, you should work with saved documents. If you are working in Microsoft Office on an unsaved document and you select **Compare**, the following message is displayed:

![Workshare Compare error message]
Licensing

After installation, you are prompted to log in to your Workshare account in order to retrieve your license entitlements. This can be in either of the following ways:

- When file share & sync is included in the installation, the Workshare desktop app is launched after install and you will see the following:

  Enter your Workshare credentials (email address and password) and click **Sign in**. Your license entitlements are retrieved and you have access to all Workshare functionality. Your license entitlements are shown in the **My Products** tab of the Workshare Configuration Manager.

  If you do not log in at this point, then...
The first time you access Workshare functionality, for example, by clicking any option in the Workshare tab, you will see the following:

![Sign in to validate your Workshare subscription]

**Note**: You can also open the Workshare Configuration Manager, select the **My Products** tab and click **Sign in**.

Enter your Workshare credentials (email address and password) for Workshare and click **Sign in**. Your license entitlements are retrieved and you have access to all Workshare functionality. Your license entitlements are shown in the **My Products** tab of the Workshare Configuration Manager.

Users who do not yet have a Workshare account can click **Create an account** in the login dialog. Workshare checks their email address and will automatically register them against your corporate Workshare account and update their license entitlement.
Chapter 2: Comparing Documents

This chapter describes Workshare Compare, a standalone application that enables you to compare two or more Microsoft Word or PDF documents. It includes the following sections:

- **Overview – Comparing Documents**, page 20, introduces the Workshare Compare application.
- **Performing Comparisons**, page 21, describes how to compare a document against an earlier version of the document or against a different document using Workshare Compare.
- **Comparing Selected Content**, page 27, describes how to compare a snippet of content with another snippet of content.
- **Ensuring Successful Comparisons**, page 28, describes how Workshare Compare performs comparisons using auto retry mode and failsafe mode.
- **Workshare Compare Main Window**, page 30, describes the Workshare Compare environment and provides an overview of the functionality available.
- **Working with redlines**, page 47, describes the tools available to you when working with the compared (redline) document after a comparison.
Overview - Comparing Documents

Note: This chapter describes how to compare Word documents and PDF files. The comparison of PowerPoint presentations is described in Chapter 3 and the comparison of Excel spreadsheets is described in Chapter 4.

The Workshare Compare application compares documents – the original document and the modified document – and produces a comparison (redline document), enabling you to instantly see any differences between them. In one view, you can see the source documents and the resulting DeltaView redline. You can compare an original document against several different modified documents and see the redline for each comparison in a different tab. Documents can be stored in your DMS or CRM, locally or on your network.

You can compare any of the following file formats:

DOC    DOCX    PDF    RTF    TXT

Workshare Compare’s powerful engine accurately and reliably displays document changes in a redline document with the differences clearly marked. For example, deleted text is red and struck through and added text is blue and double underlined. All content is compared including images, tables and embedded Microsoft Excel tables. You can review the redline, navigating between the changes and accepting or rejecting the changes to create a new and revised document. To make the review easier, you can customize how the changes are highlighted within the document.
PDF comparison

Workshare Compare can compare both regular text-based PDF files and image-based PDF files that originate from scanned documents. Regular PDF files are compared by converting them to RTF before performing a comparison. With image-based PDF files, Workshare Compare will first apply OCR (Optical Character Recognition) processing to translate the images of typewritten text into editable text and then produce an RTF file.

PDF files that originate from scanned documents may include:

- PDF files generated from files that have been scanned: OCR (Optical Character Recognition) has already been used to translate images of typewritten text into editable text. Workshare Compare supports the comparison of such PDF files.
- PDF files that have been created directly from the scanning: Where OCR has not been used and PDF files contain pure images of text. Workshare Compare applies OCR to the PDF files before performing comparisons.

Notes:

If you compare scanned PDF files without applying OCR, it may result in a blank redline.

Workshare Compare can perform OCR on the following languages: English, Danish, Dutch, Finnish, French, German, Italian, Norwegian, Polish, Portuguese, Spanish, Swedish and Russian.

Performing Comparisons

You can compare your original document against any previous version of the document or against another document entirely. For example, there may be ten versions of a document in your DMS. You can open version 3 and compare it against version 5. You can also compare a document against multiple versions. For example, you can open version 3 and compare it against version 5, version 7 and version 10.

Note: You cannot compare secure PDFs, meaning PDF files with security settings configured.

You can launch Workshare Compare and perform comparisons from within Microsoft Word, from your desktop, from right-click options or from an email and each of these scenarios is described in the following sections.

Note: Comparison of selected pieces of text, such as a single paragraph or clause, is described in Comparing Selected Content.
Launching Workshare Compare from Microsoft Word

In this scenario, you first open your document in Microsoft Word.

To compare documents:

Click Compare in the Workshare tab. The Compare Documents dialog is displayed with the open document in the Modified Document field. Select the file to compare it against as described in Launching Workshare Compare from your desktop.

Launching Workshare Compare using right-click options

You can launch Workshare Compare by right-clicking documents in File Explorer or in your DMS (iManage/OpenText/Worldox).

- Right-click the original document and select Compare with Workshare. The Compare Documents dialog is displayed with the selected document in the Original Document field. Select the files to compare it against as described in Launching Workshare Compare from your desktop.

- Select the original and modified documents, right-click and select Compare with Workshare. The Compare Documents dialog is displayed with the selected documents in the Original Document and Modified Document fields. Continue as described in Launching Workshare Compare from your desktop.

You cannot launch Workshare Compare from SharePoint using right-click options.

You can launch Workshare Compare from the Work 10 browser interface using the kebab (context) menu if you have WIIS (Workshare iManage Integration Server) installed. See this knowledge base article - Installing Workshare iManage Integration Server.
Launching Workshare Compare from email

You can launch Workshare Compare from the dropdown context menu of an attachment to an email or using the Compare button in the Workshare tab.

- Select one (or two attachments), click the dropdown and click Compare with Workshare.

The Compare Documents dialog is displayed with the attachment in the Modified Document field. Continue as described in Launching Workshare Compare from your desktop.

- With an email selected in your inbox, click Compare in the Workshare tab. If the email doesn’t include attachments, the Compare button is disabled. If the email includes one or two Word or PDF attachments, the Compare Documents dialog is displayed with the attachments selected. If the email contains more than two attachments, the following dialog is displayed:
Select the attachments you want to compare and click **Continue**. The **Compare Documents** dialog is displayed with the attachments selected. Continue as described in **Launching Workshare Compare from your desktop**.

**Note:** If you select attachments that can’t be compared for example, a DOCX and an XLSX, the **Continue** button will be disabled.

---

**Launching Workshare Compare from your desktop**

In this scenario, you launch Workshare Compare as a standalone application from your desktop or the Start menu. You then select the documents you want to compare.

**To compare documents:**

1. Double-click the Workshare Compare shortcut on your desktop or select **Workshare Compare** from the Start menu. The **Compare Documents** dialog is displayed:
2. Select the original document you want to compare:
   - Drag the file over the Original Document field, or
   - Click to the right of the Original Document field, navigate to the
document location in your local file system, SharePoint or DMS/CRM and click
Open.

The selected document is displayed in the Original Document field.

**Tip:** You can also enter text directly into the text box. Workshare Compare will
predict locations as you type. This is possible for locations accessible from the
local machine but not for locations in a DMS.

3. Select the document you want to compare with the original document:
   - Drag the file over the Modified Document field, or
   - Click to the right of the Modified Document field, navigate to the
document location in your local file system, SharePoint or DMS/CRM and click
Open.

The selected document is displayed in the Modified Document field.

**Tip!** If you want to compare a recently used file, click the dropdown ▼ in the
Original Document and Modified Document fields and select the documents
you want to compare. These lists contain the last 10 documents you have used.

**Tip!** To swap the original and modified documents, click . This button is only
available if you are comparing two documents rather than comparing multiple
documents against an original document.

4. If you want to compare the original document against another document, click .
   An additional Modified Document field is added.

5. Select the document you want to compare with the original document:
   - Drag the file over the second Modified Document field, or
   - Click to the right of the second Modified Document field, navigate to the
document location in your local file system, SharePoint or DMS/CRM and click
Open.

6. Repeat step 5 to add further documents as required.
7. From the **Rendering Set** dropdown list, select the rendering set you want to use. Rendering sets contain a set of parameters that define how changes are displayed in the redline (compared) document. You can select from the standard rendering sets provided with Workshare Compare or you can create and customize your own rendering sets (described in *Introducing Rendering Sets*).

![Rendering Set dropdown list](image)

**Note:** Clicking to the right of the **Rendering Set** field displays the Rendering Sets Manager where you can create, modify and delete rendering sets. For a full description refer to *Introducing Rendering Sets*.

8. From the **Comparison Mode** dropdown list, select the type of comparison you want to perform from the following:

- **Standard**: Workshare Compare performs a regular comparison.
- **Fast**: When comparing a DOC or DOCX file against another DOC or DOCX file, Workshare Compare performs a binary comparison which is faster than a standard comparison.

**Note:** The **Fast** option is only available if the **Enable fast comparison** parameter (**Comparison > Administration** category) in the Workshare Configuration Manager is selected.

- **Text Only**: Workshare Compare performs a text-only comparison, comparing only the text in a document and not the formatting or styles.
- **Compare without OCR**: Workshare Compare compares PDF files without first performing OCR. With image-based PDF files, Workshare Compare will first apply OCR (Optical Character Recognition) processing to translate the images of typewritten text into editable text in order to compare. If you do NOT want Workshare Compare to perform OCR, select this option.

9. Click **OK**. The comparison process is launched and a progress dialog is displayed.

**Tip:** Progress is also indicated by the shading in the Task Bar icon for Workshare Compare.
When the comparison is complete, the redline is displayed in the Workshare Compare window. If the original document has been compared against multiple documents, each redline is displayed in a different tab. For a full description of the Workshare Compare interface, refer to Workshare Compare Main Window.

\textbf{Note:} When comparing a PDF file, the display may vary according to the type of PDF - the software used to create the PDF file. For example, Adobe, Amyuni, CutePDF, novaPDF, and so on.

\section*{Comparing Selected Content}

You can use Selective Compare to run a comparison on snippets of content pasted from emails, chats or files. This is much faster and more focused than comparing an entire document. Content can include text, tables, code and images and results are displayed in the familiar Compare environment.

\textbf{To compare selected content:}

1. From the Workshare tab in Microsoft Word or Outlook, click \textbf{Selective Compare}.

2. Drag the content you want to compare into the \textbf{Original} area or click in the area to paste your content there. The content can include text, images, tables, code.

3. In the \textbf{Modified} area, drag or paste the content you want to compare with the original content.

\textbf{Tip!} To swap the original and modified content, click \textbf{\textarrow{}}.

4. Click \textbf{Compare}. The comparison is displayed in the Workshare Compare window.
Ensuring Successful Comparisons

If Workshare Compare cannot complete the comparison, it will do one of two things:

- Invoke auto retry mode, if it is enabled.
- Invoke failsafe mode, if auto retry mode is not enabled or if Workshare Compare cannot complete the comparison in auto retry mode.

Auto retry mode

If Workshare Compare is unable to complete the comparison, and auto retry mode is enabled, then Workshare Compare attempts to perform the comparison using reduced settings. For example, Workshare Compare may attempt to compare the documents without comparing field codes or without comparing footnotes. Workshare Compare repeatedly attempts to perform the comparison disabling settings one at a time until the comparison is successful.

Note: Auto retry mode is enabled in the rendering set – the Allow Auto Retry parameter in the Comparison Options category of the Rendering Sets Manager.

Once the comparison is successful, a message is displayed informing you that the comparison has been performed using reduced settings. Click OK and scroll to the Redline Options Summary, which is displayed at the beginning or end of the redline according to the settings in the selected rendering set (in the Redline Options category of the Rendering Sets Manager). Even if the rendering set does NOT have the Include Redline Options Summary parameter selected, when Workshare Compare performs an auto retry the Redline Options Summary is always displayed after the comparison.

The Redline Options Summary indicates which settings Workshare Compare disabled in order to perform the comparison. For example:

<table>
<thead>
<tr>
<th>Redline Options Summary</th>
<th>Status:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Option: Redline Statistics at End of Document</td>
<td>ON</td>
</tr>
<tr>
<td>Include Redline Comparison Summary</td>
<td>OFF</td>
</tr>
<tr>
<td>Show Line Numbering</td>
<td>OFF</td>
</tr>
<tr>
<td>Show Change Numbers</td>
<td>OFF</td>
</tr>
<tr>
<td>Show Change Bars on Left</td>
<td>ON</td>
</tr>
<tr>
<td>Show Hidden Text</td>
<td>OFF</td>
</tr>
<tr>
<td>Detect List Numbering Changes</td>
<td>ON</td>
</tr>
<tr>
<td>Compare Headers/Footers</td>
<td>ON</td>
</tr>
</tbody>
</table>
Comparing Documents

<table>
<thead>
<tr>
<th><strong>Redline Options Summary</strong></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Compare Footnotes</td>
<td>SET OFF</td>
</tr>
<tr>
<td>Display Compare Footers</td>
<td>OFF</td>
</tr>
<tr>
<td>Ignore Embedded Objects/Images</td>
<td>OFF</td>
</tr>
<tr>
<td>Compare at Character Level</td>
<td>OFF</td>
</tr>
<tr>
<td>Compare Numbers at Character Level</td>
<td>OFF</td>
</tr>
<tr>
<td>Show Moved Deletions</td>
<td>OFF</td>
</tr>
<tr>
<td>Show Changes to Spaces</td>
<td>OFF</td>
</tr>
<tr>
<td>Show Paragraph Changes</td>
<td>OFF</td>
</tr>
<tr>
<td>Ignore Case Changes</td>
<td>OFF</td>
</tr>
<tr>
<td>Ignore Textboxes</td>
<td>SET ON</td>
</tr>
<tr>
<td>Ignore Field Codes</td>
<td>OFF</td>
</tr>
<tr>
<td>Ignore Tables</td>
<td>OFF</td>
</tr>
</tbody>
</table>

**Note:** The comparison may take longer than usual because Workshare Compare is attempting to compare using different settings.

The status indications are as follows:

- **ON**: This setting is selected and was applied during the comparison.
- **OFF**: This setting is not selected and was not applied during the comparison.
- **SET ON**: This setting was not selected but was enabled by Workshare Compare and applied during the comparison.
- **SET OFF**: This setting was selected but was disabled by Workshare Compare and not applied during the comparison.

If Workshare Compare cannot complete the comparison even using reduced settings, failsafe mode is invoked.

**Failsafe mode**

If Workshare Compare is unable to complete the comparison and auto retry mode is disabled, or if Workshare Compare cannot complete even a reduced comparison in auto retry mode, then failsafe mode is invoked. Failsafe mode means that Workshare Compare performs a text-only comparison, comparing only the text in a document and not the formatting or styles.
You can manually invoke failsafe mode so that a text-only comparison is performed. You may want to do this if, after a full comparison, your redline was not fully shown in Workshare Compare for any reason. Additionally, you may want to do this if you are more interested to see text changes rather than formatting and style changes.

**To manually invoke failsafe mode:**

Before running the comparison, select **Text Only** as the **Comparison Mode** in the *Compare Documents* dialog.

### Workshare Compare Main Window

The Workshare Compare main window enables you to view redlines - the results of a comparison between an original document and a modified document. You can view (in one work area) both source documents, the redline and a summary of the changes between the two source documents.

When you select to run multiple comparisons, each resulting redline is displayed in an individual tab.
Moving and placing windows

The Source Documents window and the Change Summary window can easily be moved to different positions in the Workshare Compare main window according to individual preference.

Left-click the title bar of the Source Documents window or Change Summary window and then drag the window to your preferred position. The selected window will float over the workspace.

To dock a window:

Left-click the title bar of a floating window and keep the mouse button pressed. Positioning arrows appear at the top, bottom, left and right of the Workshare Compare main window, as well as in the center.

Move the mouse pointer over the required positioning arrow and release the mouse button. The window is docked in the selected location. For example, dragging the Change Summary window over the left positioning arrow will dock the Change Summary window down the left side of the Workshare Compare main window.

To hide a window:

Click in the top right corner of the Source Documents window or the Change Summary window or use the options in the Layout group on the Home tab.
To auto-hide a window:

Click \( \text{\textsuperscript{}} \) in the top right corner of the Source Documents window or the Change Summary window. The selected window is hidden with just a tab remaining.

For example, if the Change Summary window is displayed on the left side of the Workshare Compare main window:

5. Click \( \text{\textsuperscript{}} \), the Change Summary window is hidden with just a tab displayed on the left side.

6. Hover over this tab, the Change Summary window is displayed again and you can work in it as required.

7. Click elsewhere, for example in the redline, the Change Summary window is automatically hidden again.

To turn off auto-hide, click \( \text{\textsuperscript{}} \). 
Quick access toolbar

The quick access toolbar provides one-click access to popular functionality. By default, the **New Comparison**, **Open Comparison**, **Save** and **Save As** buttons are included in the quick access toolbar. By clicking the arrow to the right of the quick access toolbar, you can customize it as follows:

- Select/deselect the **New Comparison**, **Open Comparison**, **Save** or **Save As** options to display/hide these options in the quick access toolbar.
- Select **More Commands** to add additional options to the quick access toolbar.
- Select **Show Below the Ribbon** to display the quick access toolbar below the ribbon.
- Select **Minimize the Ribbon** to hide the details of the ribbon until you click the Home, Review or View tabs.

**Note**: To change the commands that appear in the quick access toolbar, right-click in the ribbon and select **Customize the Ribbon**. Refer to **Customize the Workshare ribbon**.

File menu

Clicking **File** displays a menu with the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Comparison</td>
<td>Opens the <em>Compare Documents</em> dialog enabling you to perform a new comparison. Refer to <a href="#">Launching Workshare Compare from your desktop</a>.</td>
</tr>
<tr>
<td>Open Comparison</td>
<td>Enables you to open a saved comparison. Comparisons are saved as Workshare DeltaFiles (.WDF). Refer to <a href="#">Opening saved Workshare DeltaFiles</a>.</td>
</tr>
<tr>
<td>Save</td>
<td>Enables you to save the current comparison. Refer to <a href="#">Saving redlines</a>.</td>
</tr>
<tr>
<td>Save As</td>
<td>Includes the following sub-options:</td>
</tr>
<tr>
<td>Comparison document</td>
<td>Enables you to save the redline as a WDF, DOC, DOCX, TXT, RTF, HTM or PDF file. Refer to <a href="#">Saving redlines</a>.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Word document with Track Changes</strong></td>
<td>Enables you to save the redline as a DOCX document with the changes shown as track changes. Refer to <em>Saving redline as track change document</em>.</td>
</tr>
<tr>
<td><strong>Save to My Files</strong></td>
<td>Includes the following sub-options:</td>
</tr>
<tr>
<td><strong>As Comparison document</strong></td>
<td>Enables you to save the redline to Workshare online as a WDF, DOC, DOCX, TXT, RTF, HTM or PDF file. Refer to <em>Saving redlines to Workshare online</em>.</td>
</tr>
<tr>
<td><strong>As Word document with Track Changes</strong></td>
<td>Enables you to save the redline to Workshare online as a DOCX document with the changes shown as track changes. Refer to <em>Sharing to Workshare online as track change document</em>.</td>
</tr>
<tr>
<td><strong>Share</strong></td>
<td>Includes the following sub-options:</td>
</tr>
<tr>
<td><strong>As Comparison document</strong></td>
<td>Enables you to share the redline to a group in Workshare online as a WDF, DOC, DOCX, TXT, RTF, HTM or PDF file. Refer to <em>Sharing redlines to Workshare online</em>.</td>
</tr>
<tr>
<td><strong>As Word document with Track Changes</strong></td>
<td>Enables you to share the redline to a group in Workshare online as a DOCX document with the changes shown as track changes. Refer to <em>Sharing to Workshare online as track change document</em>.</td>
</tr>
<tr>
<td><strong>Email</strong></td>
<td>Includes the following sub-options:</td>
</tr>
<tr>
<td><strong>Attach as PDF</strong></td>
<td>Converts the redline to PDF and opens a new email window with the PDF attached. Refer to <em>Sending by email</em>.</td>
</tr>
<tr>
<td><strong>Attach as PDF (only pages with changes)</strong></td>
<td>Converts the changed pages in the redline to PDF and opens a new email window with the PDF attached. Refer to <em>Sending by email</em>.</td>
</tr>
<tr>
<td><strong>Attach as Word document with Track Changes</strong></td>
<td>Converts the redline to a Word document with the changes shown as track changes and opens a new email window with the document attached. Refer to <em>Sending by email as track change document</em>.</td>
</tr>
<tr>
<td><strong>More email options….</strong></td>
<td>Enables you to select which documents from the comparison to email and in what format. Refer to <em>Sending by email</em>.</td>
</tr>
<tr>
<td><strong>Print</strong></td>
<td>Enables you to print the redline and includes the following sub-options: Refer to <em>Printing redlines</em>.</td>
</tr>
<tr>
<td><strong>Comparison only</strong></td>
<td>Enables you to print the redline.</td>
</tr>
<tr>
<td><strong>Comparison + Modified</strong></td>
<td>Enables you to print the redline and the modified source document.</td>
</tr>
</tbody>
</table>
### Home tab

The Home ribbon provides access to key functionality in Workshare Compare.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Comparison + Modified + Original</strong></td>
<td>Enables you to print the redline, the modified source document and the original source document.</td>
</tr>
<tr>
<td><strong>Print Preview</strong></td>
<td>Enables you to preview the print output and includes the following sub-options:</td>
</tr>
<tr>
<td><strong>Comparison only</strong></td>
<td>Enables you to preview the redline.</td>
</tr>
<tr>
<td><strong>Comparison + Modified</strong></td>
<td>Enables you to preview the redline and the modified source document.</td>
</tr>
<tr>
<td><strong>Comparison + Modified + Original</strong></td>
<td>Enables you to preview the redline, the modified source document and the original source document.</td>
</tr>
<tr>
<td><strong>Help</strong></td>
<td>Includes the following sub-options:</td>
</tr>
<tr>
<td><strong>Help</strong></td>
<td>Provides access to online help.</td>
</tr>
<tr>
<td><strong>About</strong></td>
<td>Displays version and copyright information about Workshare Compare.</td>
</tr>
<tr>
<td><strong>Keyboard shortcuts</strong></td>
<td>Displays a list of keyboard shortcuts available in Workshare Compare.</td>
</tr>
<tr>
<td><strong>License</strong></td>
<td>Displays information about your Workshare Compare license in the My Products page of the Workshare Configuration Manager.</td>
</tr>
<tr>
<td><strong>Workshare Config Manager</strong></td>
<td>Opens the Workshare Configuration Manager where, if you have permission, you can configure system parameters. Refer to <em>Introducing the Workshare Configuration Manager</em> for further information.</td>
</tr>
<tr>
<td><strong>Exit Workshare Compare</strong></td>
<td>Closes the Workshare Compare application. You are prompted to save any open redlines.</td>
</tr>
</tbody>
</table>
The options are described in the following table.

<table>
<thead>
<tr>
<th>Group</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>New Comparison</td>
<td>Opens the <em>Compare Documents</em> dialog enabling you to perform a new comparison. Refer to <em>Launching Workshare Compare from your desktop.</em></td>
</tr>
<tr>
<td>Comparison document</td>
<td>Save As</td>
<td>Includes the following sub-options:</td>
</tr>
<tr>
<td></td>
<td>Comparison document</td>
<td>Enables you to save the redline as a WDF, DOC, DOCX, TXT, RTF, HTM or PDF file. Refer to <em>Saving redlines.</em></td>
</tr>
<tr>
<td></td>
<td>Word document with Track Changes</td>
<td>Enables you to save the redline as a DOCX document with the changes shown as track changes. Refer to <em>Saving redline as track change document.</em></td>
</tr>
<tr>
<td>Save to My Files</td>
<td>As Comparison document</td>
<td>Enables you to save the redline to Workshare online as a WDF, DOC, DOCX, TXT, RTF, HTM or PDF file. Refer to <em>Saving redlines to Workshare online.</em></td>
</tr>
<tr>
<td></td>
<td>As Word document with Track Changes</td>
<td>Enables you to save the redline to Workshare online as a DOCX document with the changes shown as track changes. Refer to <em>Saving to Workshare online as track change document.</em></td>
</tr>
<tr>
<td>Share</td>
<td>As Comparison document</td>
<td>Enables you to share the redline to a group on Workshare online as a WDF, DOC, DOCX, TXT, RTF, HTM or PDF file. Refer to <em>Sharing redlines to Workshare online.</em></td>
</tr>
<tr>
<td></td>
<td>As Word document with Track Changes</td>
<td>Enables you to share the redline to a group on Workshare online as a DOCX document with the changes shown as track changes. Refer to <em>Sharing to Workshare online as track change document.</em></td>
</tr>
<tr>
<td>Email</td>
<td>Attach as PDF</td>
<td>Converts the redline to PDF and opens a new email window with the PDF attached. Refer to <em>Sending by email.</em></td>
</tr>
<tr>
<td></td>
<td>Attach as PDF (only pages with changes)</td>
<td>Converts the changed pages in the redline to PDF and opens a new email window with the PDF attached. Refer to <em>Sending by email.</em></td>
</tr>
</tbody>
</table>
## Comparing Documents

<table>
<thead>
<tr>
<th>Group</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attach as Word document with Track Changes</td>
<td></td>
<td>Converts the redline to a Word document with the changes shown as track changes and opens a new email window with the document attached. Refer to <em>Sending by email as track change document</em>.</td>
</tr>
<tr>
<td>More email options…</td>
<td></td>
<td>Enables you to select which documents from the comparison to email and in what format. Refer to <em>Sending by email</em>.</td>
</tr>
<tr>
<td>Print</td>
<td></td>
<td>Enables you to print the redline and includes the following sub-options: Refer to <em>Printing redlines</em>.</td>
</tr>
<tr>
<td>Comparison only</td>
<td></td>
<td>Enables you to print the redline.</td>
</tr>
<tr>
<td>Comparison + Modified</td>
<td></td>
<td>Enables you to print the redline and the modified source document.</td>
</tr>
<tr>
<td>Comparison + Modified + Original</td>
<td></td>
<td>Enables you to print the redline, the modified source document and the original source document.</td>
</tr>
<tr>
<td>Close All</td>
<td></td>
<td>Closes all open comparisons.</td>
</tr>
<tr>
<td>Convert PDF</td>
<td></td>
<td>Enables you to convert the redline to PDF. Refer to <em>Converting redline to PDF</em>.</td>
</tr>
<tr>
<td>Word</td>
<td></td>
<td>Includes the following sub-options:</td>
</tr>
<tr>
<td>Open in Word</td>
<td></td>
<td>Opens the redline in Microsoft Word where you can edit it. Refer to <em>Editing redlines</em>.</td>
</tr>
<tr>
<td>Open in Word with Track Changes</td>
<td></td>
<td>Opens the redline in Microsoft Word with the changes converted to track changes so you can implement changes using track changes functionality. Refer to <em>Showing changes as track changes</em>.</td>
</tr>
<tr>
<td>Change Navigation</td>
<td>Change Summary</td>
<td>Displays/hides the Change Summary window.</td>
</tr>
<tr>
<td>Search</td>
<td></td>
<td>Displays the Search tab in the Change Summary window enabling you to search for specified text or keywords in the redline and source documents.</td>
</tr>
<tr>
<td>Previous</td>
<td></td>
<td>Navigates to the previous change and highlights the entire change in the redline. Refer to <em>Navigating between changes</em>.</td>
</tr>
<tr>
<td>Next</td>
<td></td>
<td>Navigates to the next change and highlights the entire change in the redline. Refer to <em>Navigating between changes</em>.</td>
</tr>
<tr>
<td>Group</td>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>--------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>First</strong></td>
<td></td>
<td>Navigates to the first change and highlights the entire change in the redline. Refer to <em>Navigating between changes</em>.</td>
</tr>
<tr>
<td><strong>Last</strong></td>
<td></td>
<td>Navigates to the last change and highlights the entire change in the redline. Refer to <em>Navigating between changes</em>.</td>
</tr>
<tr>
<td><strong>Specific</strong></td>
<td></td>
<td>Enables you to navigate to a specific change number. The entire change is highlighted in the redline. Refer to <em>Navigating to a specific change number</em>.</td>
</tr>
<tr>
<td><strong>Comparison Themes</strong></td>
<td><strong>Select</strong></td>
<td>Enables you to select a different rendering set from the dropdown list and Workshare Compare automatically re-runs the comparison applying the selected rendering set. Refer to <em>Introducing Rendering Sets</em>.</td>
</tr>
<tr>
<td><strong>Edit</strong></td>
<td></td>
<td>Opens the Rendering Sets Manager where you can apply different rendering sets to a comparison and, if you have permission, you can add, edit and delete rendering sets. Refer to <em>Introducing Rendering Sets</em>.</td>
</tr>
<tr>
<td><strong>Layout</strong></td>
<td><strong>Select</strong></td>
<td>Enables you to select what is displayed in the Workshare Compare window.</td>
</tr>
<tr>
<td><strong>Comparison only</strong></td>
<td></td>
<td>Hides the Source Documents window and displays the redline only.</td>
</tr>
<tr>
<td><strong>Comparison + Original</strong></td>
<td></td>
<td>Displays the redline as well as the original document in the Source Documents window.</td>
</tr>
<tr>
<td><strong>Comparison + Modified</strong></td>
<td></td>
<td>Displays the redline as well as the modified document in the Source Documents window.</td>
</tr>
<tr>
<td><strong>Comparison + Original + Modified</strong></td>
<td></td>
<td>Displays the redline as well as both source documents.</td>
</tr>
</tbody>
</table>
More tab

The More ribbon provides access to other useful functionality.

The options are described in the following table.

<table>
<thead>
<tr>
<th>Group</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Original/Modified</td>
<td>Swap</td>
<td>Swaps the original and modified documents. Refer to <em>Swapping the source documents</em>.</td>
</tr>
<tr>
<td>Mode</td>
<td>Comparison Mode</td>
<td>Enables you to select a comparison mode from the dropdown list and Workshare Compare automatically re-runs the comparison in the selected mode – <em>Fast</em>, <em>Standard</em>, <em>Text Only</em> or <em>Image Based PDF</em>.</td>
</tr>
<tr>
<td>Info</td>
<td>Help</td>
<td>Includes the following sub-options:</td>
</tr>
<tr>
<td></td>
<td>Help</td>
<td>Provides access to online help.</td>
</tr>
<tr>
<td></td>
<td>About</td>
<td>Displays version and copyright information about Workshare Compare.</td>
</tr>
<tr>
<td></td>
<td>Keyboard Shortcuts</td>
<td>Displays a list of keyboard shortcuts available in Workshare Compare.</td>
</tr>
<tr>
<td></td>
<td>License</td>
<td>Displays information about your Workshare Compare license in the My Products page of the Workshare Configuration Manager.</td>
</tr>
</tbody>
</table>
Customize the Workshare ribbon

To change the commands that appear in the Workshare Compare ribbons and quick access toolbar, right-click in the ribbon and select **Customize the Ribbon**.

![Customize the Ribbon](image)

To customize the Compare environment to suit your needs, you can select which commands to include in the **Home** and **More** tabs or add new tabs.

The redline

The DeltaView redline shows the results of the comparison between the original document and the modified document. Changes are marked according to the rendering set applied to the comparison. For example, deleted text could be **red and struck through** and added text could be **blue and underlined**.

You can navigate between the changes in the redline and accept/reject the changes to create a new and revised document. You can also save the redline locally, or to your DMS or to Workshare online. All of these options are described in *Working with Redlines*.
Comparing Documents

Redline tabs

When the original document has been compared against multiple modified documents, each resulting redline is displayed in a different tab. Select the tab header to display the comparison in the Workshare Compare window. You can also display the tabs simultaneously side by side by clicking and dragging the tab header across the Workshare Compare window.

Redline right-click menu

Right-clicking text or changes in the redline displays a popup menu, providing rapid access to some of the more commonly used tools.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy</td>
<td>Copies selected text to the clipboard.</td>
</tr>
<tr>
<td>Select All</td>
<td>Selects all the content of the redline.</td>
</tr>
<tr>
<td>Find</td>
<td>Displays the Search tab in the Change Summary window enabling you to search for specified text or keywords in the redline and source documents.</td>
</tr>
<tr>
<td>Find Next</td>
<td>When you have specified text or a keyword in the Search tab, navigates to the next occurrence of the specified search text or keyword.</td>
</tr>
<tr>
<td>Edit redline</td>
<td>Opens the redline in Microsoft Word where you can edit it. Refer to Editing redlines.</td>
</tr>
<tr>
<td>Convert to Track Changes</td>
<td>Opens the redline in Microsoft Word with the changes converted to track changes so you can implement changes using track changes functionality. Refer to Showing changes as track changes.</td>
</tr>
<tr>
<td>Zoom</td>
<td>Enables you to change the display of the redline from 20% to 200% of its original size.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Link to Move</strong></td>
<td>When text has been moved to another position, navigates and highlights the text in its new or previous position in the redline.</td>
</tr>
<tr>
<td></td>
<td>• When right-clicking text in its new position, clicking <strong>Link to Move</strong> highlights the text in its previous position.</td>
</tr>
<tr>
<td></td>
<td>• When right-clicking text in its original position, clicking <strong>Link to Move</strong> highlights the text in its new position.</td>
</tr>
<tr>
<td></td>
<td>You must right-click a move-type change for this option to be available.</td>
</tr>
<tr>
<td><strong>Link to Change</strong></td>
<td>Jumps to the redline Summary (at the end of the redline) highlighting the selected change. You must right-click a change for this option to be available.</td>
</tr>
</tbody>
</table>

**Note:** The *Include Redline Comparison Summary* parameter (Redline Options category of the Rendering Sets Manager) must be selected in the applied rendering set.

---

**Redline comparison summary**

At the beginning or end of the redline, you can see a summary of the comparison and a list of the changes found.

| Redline Summary:                                                                 |
|-------------------------------|-----------------------------------------------------------------------------------|
| **No.** | **Change** | **Text**                                                                                          |
| 1-2   | Change     | “Dear Sirs,” changed to “Dear Sir/Madam,”                                                      |
| 3     | Deletion   | 5. The Lead Manager...with the proposed issue.                                                 |
| 4     | Insertion  | 5.                                                                                               |
| 5     | Change     | “6. Our comfort letter will be provided” changed to “Our comfort letter will be provided”     |
| 6     | Insertion  | 6.                                                                                               |
| 7     | Change     | “7. For the avoidance of doubt, nothing” changed to “For the avoidance of doubt, nothing”    |

In order for the redline to include this summary, the *Include Redline Comparison Summary* parameter in the Redline Options category of the Rendering Sets Manager must be selected in the applied rendering set.
Change Summary window

The Change Summary window provides a list of changes found between the source documents. Selecting a change highlights the change in the redline and displays the position of the change in both the source documents. From the Change Summary window, you accept and reject changes. Refer to Reviewing changes.

You can hide/display the Change Summary window by clicking Change Summary in the Home tab.

Tip! The Change Summary window is by default positioned down the left side of the Workshare Compare environment. It can be moved as required. Refer to Moving and placing windows.

The Change Summary window includes two tabs – Changes and Search – and the Changes tab has three views. These are described in the following sections.

Changes tab Category View

![Changes tab Category View](image)
The Changes tab, Category View displays all the changes between the original document and the modified document according to the type of change. The changes can be grouped into any of the following categories:

- **Numbering Changes**: Any changes to numbering lists identified in a document.
- **Whitespace Changes**: Changes that only involve whitespace – ie deletion/insertion of spaces or tabs, or a space changing to a tab or 3 spaces changing to tabs.
- **Capitalization Changes**: Any changes to the capitalization of a word.
- **Punctuation Changes**: Any changes to a punctuation mark.
- **Spelling Corrections**: Changes where a single word replacement includes the deletion of a word that is not a dictionary word and the insertion of a dictionary word in its place. The replacement word must also be a spell check suggestion for the replaced word – for instance replacing ‘recieve’ with ‘receive’.
- **Word Variations**: Changes which involve changing the form a word ie replacing ‘confirms’ with ‘confirmed’ – the two words (original and replacement) must come from the same stem word and just have different endings.
- **Matching Changes**: Changes that are repeated and identical.
- **Suggested Changes**: Changes that a reviewer could have neglected to make. For example, there are 400 instances of “ACME INC” in the original document but the reviewer has only changed 399 of these to “Workshare Inc”. The Suggested Changes category will indicate that there is 1 change that might have been missed.
- **Style Changes**: Changes made to styles in a document.
- **Font Changes**: Changes made to font type, font style, font colour, underline style, underline color and font effects.
- **Footnote Changes**: Any changes in the footnotes of a document.
- **Endnote Changes**: Any changes in the endnotes of a document.
- **Header Changes**: Any changes in the headers of a document.
- **Footer Changes**: Any changes in the footers of a document.
- **Placeholder Changes**: Blocks of placeholder text that are found to be matching between the original and modified documents. While these are not changes between the two documents as such, they highlight areas where the editing of the document may be incomplete. Typical blocks of placeholder text might be ‘[Client Name]’, ‘[Company Address]’ etc.
- **Boilerplate Changes**: Changes that occur inside blocks of boilerplate text. These changes merit special attention as in general boilerplate text should not be modified. Note that the change is only marked as a boilerplate change if it is found inside an occurrence of one of the boilerplate text items in the original document.
- **Comment Changes**: Changes that have been made to comments.
- **Uncategorized Changes**: Changes that do not fall into any of the above groups.
Changes tab List View

The **Changes tab, List View** displays all the changes between the original document and the modified document in the order that they occur. The following information is shown for each change:

- **#**: The number of the change in the document. A change may have two numbers when it includes two actions. For example, a deletion and an addition.
- **Page, Line**: The page number and the line number in the original document where the change occurs.
- **Accept**: Whether you accept the change or not.
- **Change Text**: Details of the change.

Changes tab Status View

The **Changes tab, Status View** displays all the changes between the original document and the modified document according to their review status – **Accepted**, **Not Accepted** or **Flagged**. When you have selected the checkbox to the left of a change, it appears under **Accepted**.
Search tab

The Search tab enables you to search for changes in the redline that include a specific keyword or text. Refer to Searching for changes.

Source Documents window

The Source Documents window is where you can view the documents that have been compared. You can select (from the Layout group in the Home tab) to display the original document, the modified document or both documents in the Source Documents window.
You can scroll through both documents. Selecting a point in one source document automatically scrolls the other source document as well as the redline to the same point. The source documents are read-only and cannot be modified in any way. The name of the source document is shown above the document.

**Tip!** The **Source Documents window is by default positioned across the top of the Workshare Compare environment. It can be moved as required. Refer to Moving and placing windows.**

Right-clicking text in the original document or the modified document displays a popup menu, providing rapid access to some of the more commonly used tools.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy</td>
<td>Copies selected text to the clipboard.</td>
</tr>
<tr>
<td>Select All</td>
<td>Selects all the content of the original or modified document.</td>
</tr>
<tr>
<td>Find</td>
<td>Displays the <strong>Search</strong> tab in the Change Summary window enabling you to search for specified text or keywords in the redline and source documents.</td>
</tr>
<tr>
<td>Find Next</td>
<td>When you have specified text or a keyword in the <strong>Search</strong> tab, navigates to the next occurrence of the specified search text or keyword.</td>
</tr>
<tr>
<td>Zoom</td>
<td>Enables you to change the display of the original or modified document from 20% to 200% of its original size.</td>
</tr>
</tbody>
</table>

### Working with Redlines

This section describes the tools available to you when working with the DeltaView redline after a comparison.

### Navigating changes

After performing a comparison, you can review the redline (the result of the comparison) and look through the changes between the original and modified documents. You can move between changes in the redline by jumping from change to change or searching for a specific change using change numbers or keywords. You can also accept or reject the changes and create a new document based on your decisions – refer to **Reviewing changes**.
Navigating between changes

Selecting a change in the Change Summary window highlights the change in the redline and displays the position of the change in both of the source documents.

- Click **Previous** in the Home tab to move to the previous change and highlight the entire change in the redline. Click **First** to move to the first change in the redline.
- Click **Next** in the Home tab to move to the next change and highlight the entire change in the redline. Click **Last** to move to the last change in the redline.

Navigating to a specific change number

Changes are allocated numbers, which are displayed next to the change in the Change Summary window. A change may have two numbers when it includes two actions, for example, a deletion and an addition. You can move to a specific change number in the redline.

**To navigate to a specific change number:**

1. Click **Specific** in the Home tab. The following dialog is displayed:

![Workshare Compare dialog](image)

   - In the **Change Number** field, enter the number of the change you want to display in the redline.
   - Click **Go To**. The entire change is highlighted in the redline.
   - Repeat steps 2 and 3 to navigate to further changes as required.
   - Click **Close** to close the dialog.

---

**Tip!** To maximize this feature, apply a rendering set with the **Show Change Numbering** parameter selected in the **Redline Rendering** category, Change Numbering section. This shows all the change numbers against each change in the redline, for example, 1

Dear Mr/Madam
Searching for changes

You can search for changes in the redline that include a specified keyword or text. Workshare Compare can search only the changes for the specified text or it can search the text of the original or modified documents.

To search for a change:

1. In the Change Summary window, select the Search tab or click Search in the Home tab.
2. In the text box at the top of the Search tab, enter the search criteria – the word or words for which you want to search.
3. If the case is not important, select the Ignore Case checkbox.
4. Select where you want to search from the dropdown list. The options are as follows:
   - **Search changed text only**: Searches through all text in the redline that has been changed.
   - **Search text near a change**: Searches through all text in the redline that has been changed and also text that is within 100 characters of a change.
   - **Search Original Document text**: Searches through all text in the original document.
   - **Search Modified Document text**: Searches through all text in the modified document.
   - **Search all Redline text**: Searches through all text in the redline.
5. Click Search. A list of changes that include the specified word or words is displayed in the lower text area.

Selecting a change in the search results highlights the change in the redline and displays the position of the change in both the source documents.
Reviewing changes

You can accept and reject changes from within Workshare Compare and create a new Word document that includes all your changes. Changes can be accepted/rejected individually or as a group. Using the Category View of the Changes tab, you can choose to accept or reject an entire category. For example, the Matching Changes category includes changes that are repeated and identical and you can accept or reject them all at one time. Switching to Status View provides an easy way to quickly see what changes haven’t yet been reviewed.

To accept/reject changes:

1. Review the changes that you care about and mark them in any of the following ways:
   - In the Change Summary window, select the checkbox to the left of an individual change to accept it.
   - In Category View, select the checkbox to the left of a category to accept all changes in that category.

   **Tip! You can select all changes in a category by selecting the category checkbox and then deselect one or two changes within that category as required.**

   - Right-click an individual change or a category and select Flag. This is a way to highlight the change – perhaps for future consideration or to check sources.
   - Right-click an individual change or a category and select Mark as Read. This is a way to indicate that you have reviewed the change but do not want to give it a status.

   **Note: To reset a change marked as read, select Mark as Unread from the right-click menu.**

2. When you have completed your review, click Apply Accepted Changes at the bottom of the Change Summary window. A new Word document is opened with the changes accepted or rejected according to your selection. You can save this document as your new master document.

   **Note: Changes to comments (grouped in the Comments category) will not be accepted.**

The comparison is not altered in any way so you can return to the comparison in Workshare Compare and change your mind about whether to accept changes or not. Every time you click Apply Accepted Changes, a new Word document is opened with the current accept/reject statuses applied.

You can also save the comparison as WDF file and this will save all your selections along with the source documents and redline document. You can open this WDF at a later time and continue working or send it a colleague for further review.
Editing redlines

A redline remains an accurate comparison of two documents and cannot be directly edited in Workshare Compare. However, you can open the redline in Microsoft Word and edit the document as required. There are two ways of opening the redline in Word – one where the changes appear as text and another where the changes appear as track changes.

Showing changes as text

Using this method, changes appear as normal text with just the formatting to identify them. For example, if the rendering set used in the comparison showed inserted text as red with a double underline, then the text will appear as red with a double underline in Word.

To open the redline in Word:

1. In the Home tab, click Word and then Open in Word or right-click in the redline and select Edit redline. The redline is opened in Microsoft Word with the default name redline.docx. All the changes are displayed as ordinary text but with formatting marks indicating whether they are additions, deletions and so on.

2. Edit the document as required.

3. Save the document. By default, the document is saved in a temporary folder.

Showing changes as track changes

Using this method, the changes are converted to track changes and you can implement the changes using Microsoft Word’s track changes functionality.

Note: The converting to track changes functionality is only enabled, if the Enable Convert to Track Change functionality parameter (Comparison > User Interface category) in the Workshare Configuration Manager is selected.

To convert to track changes:

1. In the Home tab, click Word and then Open in Word with Track Changes. The redline is opened in Microsoft Word with all the changes displayed as track changes.

2. Review the track changes and implement them as required.

3. Save the document. By default, the document is saved in a temporary folder.

Changing the comparison

You can re-run a comparison swapping the source documents, changing the comparison mode, applying a different rendering set or changing specific comparison options.
Swapping the source documents

You can re-run a comparison exchanging the original document for the modified document and the modified document for the original document. For example, if you selected Document A as the original document and Document B as the modified document, Workshare Compare compares Document A to Document B and presents the changes made to Document A. You can then swap the original and modified documents so that Document B is now the original document and Document A is the modified document. Workshare Compare automatically re-runs the comparison, comparing Document B to Document A, and presents the changes made to Document B.

To swap the source documents:

Click Swap in the More tab to swap the source documents. Workshare Compare automatically runs a new comparison, using the modified document as the original document and the original document as the modified document. The new redline is displayed in the same tab replacing the first comparison.

Changing the comparison mode

You can re-run a comparison using a different comparison mode (or type) if required.

To re-run a comparison using a different mode:

In the More tab, click Comparison Mode and then select the required mode from the following:

- **Fast**: Workshare Compare performs a fast comparison. When comparing a .DOC file against another .DOC file, Workshare Compare performs a binary comparison which is faster than a standard comparison because it is comparison at the binary level. When comparing a .DOCX file against another .DOCX file, Workshare Compare performs a faster comparison by converting the documents to DOC followed by comparison at the binary level.

  **Note:** The Fast option is only available if the Enable fast comparison parameter (Comparison > Administration category) in the Workshare Configuration Manager is selected.

- **Standard**: Workshare Compare performs a regular comparison.
- **Text Only**: Workshare Compare performs a text-only comparison, comparing only the text in a document and not the formatting or styles.
- **Image Based PDF**: Workshare Compare will re-run the comparison and force OCR processing on scanned/image content. You may want to try this if Workshare Compare has performed a Standard or Fast comparison and some scanned/image content has not been converted to text.
Comparing Documents

Note: This type of ‘forced’ OCR may be useful when scanned pages are difficult to detect, for example, when they have lots of annotations on top of the scans like Bates numbering, etc. or when the text is actually vector output (from a CAD product for example) and there are no actual characters with fonts in the PDF.

Workshare Compare re-runs the comparison using the selected mode and displays the resulting redline in the Workshare Compare main window.

Applying a different rendering set

You can re-run a comparison using a different rendering set.

To re-run a comparison with a different rendering set:

1. In the Home tab, click Select in the Comparison Themes group. A list of the currently defined rendering sets is displayed.

2. Select the rendering set to apply.

Workshare Compare re-runs the comparison using the selected rendering set and displays the resulting redline in the Workshare Compare main window.
Changing the comparison options

You can re-run a comparison changing specific options within the rendering set.

**To re-run a comparison with different options:**

1. In the **Home** tab, click **Edit** in the **Comparison Themes** group. The Rendering Sets Manager is displayed.

2. Edit the rendering set parameters as required. For example, select the **Ignore Tables** checkbox. Rendering set parameters are described in *Rendering Set Parameters*.

3. Do one of the following:
   - Click **Apply**. Workshare Compare re-runs the comparison using the selected parameters and displays the resulting redline in the Workshare Compare main window. Click **OK** to close the Rendering Sets Manager. Any changes you made to the rendering set parameters are lost.
Click **OK**. The save dialog is displayed. Enter the name of an existing rendering set to overwrite a rendering set or enter a new name to create a new rendering set. Do not use the following characters when naming rendering sets: `<, >, ;, \, ", /, \ or |. Click **Yes**. Workshare Compare re-runs the comparison using the revised options and saves the revised options as the specified rendering set. Click **No**. Workshare Compare re-runs the comparison using the revised options and saves the revised options as a temporary rendering set called “Custom rendering set”.

**Note:** The “Custom rendering set” will be selected in the Rendering Set dropdown list the next time the Rendering Sets Manager is opened. However, once you navigate away from the “Custom rendering set” and a different rendering set is selected and the Rendering Sets Manager is closed, the “Custom rendering set” is lost.

### Distributing redlines

After you have compared your documents, Workshare Compare provides many options for saving or circulating the redline. Workshare’s DeltaView redline can be distributed in many formats, such as PDF or TXT or DOCX. Only if it is distributed as a WDF will your ‘Accept’ and ‘Flag’ selections, as well as the source documents, be included. WDF files can only be opened in Workshare Compare. The redline can also be distributed as a Word document with the changes shown as track changes. The following sections describe how you can distribute your redlines:

- Save locally or to your DMS, refer to [Saving redlines](#)
- Save to Workshare online, refer to [Saving redlines to Workshare online](#)
- Share to Workshare online, refer to [Sharing redlines to Workshare online](#)
- Email, refer to [Sending by email](#)
- Print, refer to [Printing redlines](#)
- Convert to PDF, refer to [Converting redline to PDF](#)
Saving redlines

You can save the redline as a Workshare Compare DeltaFile (WDF), which contains all three documents (original, modified and redline) as well as your ‘Accept’ and ‘Flag’ selections. You can also save just the redline as a DOC/DOCX, RTF, HTM, TXT or PDF file or you can save the redline as a track change document.

You can save the redline to your DMS/CRM, SharePoint or locally. The following procedure describes how to save to NetDocuments as an example.

To save the redline:

1. Click Save As and then Comparison document in the Home tab (or quick access toolbar or File menu). The following dialog is displayed.

```
Workshare Compare

Save

What do you want to do with the document?

Save a New Document

Help

OK  Cancel

Save the comparison as a new document or version in the current document system...
```

2. Select whether you want to save the comparison as a new document or attach it to the original or modified documents.
3. Click **OK**. The NetDocuments Save As dialog is displayed.

![NetDocuments Save As dialog](image)

**Notes:**

- *If you are not working with a DMS or SharePoint, the LocalStore Save As dialog is displayed.*

- *If you click **Cancel** in the DMS save dialog, a message is displayed asking if you would like to save the redline locally.*

- *Tip! If you are working with a DMS or SharePoint but both documents compared are local documents, then you can press the **Shift** key while clicking **Save** and the LocalStore Save As dialog is displayed.*

4. Browse to the location where you want to save the comparison and modify the name of the comparison as required.
5. From the **Save as type** dropdown list, select the format for the saved file from the following:

- **Workshare DeltaFile** (*.wdf)**
  Saves both the redline and the source documents, as well as your ‘Accept’ and ‘Flag’ selections, as a Workshare DeltaFile. This file can only be opened in Workshare Compare.

- **Word Document** (*.doc/*.docx)**
  Saves the redline as a Microsoft Word file. The source documents and your ‘Accept’ and ‘Flag’ selections are not saved.

- **Text Only** (*.txt)**
  Saves the redline as a text file. The source documents and your ‘Accept’ and ‘Flag’ selections are not saved.

- **Rich Text Format** (*.rtf)**
  Saves the redline as an RTF file. The source documents and your ‘Accept’ and ‘Flag’ selections are not saved.

- **HTML Document** (*.htm)**
  Saves the redline as a HTML document. The source documents and your ‘Accept’ and ‘Flag’ selections are not saved.

- **Adobe Acrobat File** (*.pdf)**
  Saves the redline as a PDF file. The source documents and your ‘Accept’ and ‘Flag’ selections are not saved.

- **Adobe Acrobat PDF/A File** (*.pdf)**
  Saves the redline as a PDF/A file. The source documents and your ‘Accept’ and ‘Flag’ selections are not saved.

6. Click **Save**.

**Saving redline as track change document**

You can also save the redline as a Microsoft Word file that shows the changes as track changes.

*Note: The converting to track changes functionality is only enabled, if the **Enable Convert to Track Change functionality** parameter (**Comparison > User Interface** category) in the Workshare Configuration Manager is selected.*

**To save redlines with changes as track changes:**

1. Click **Save As** and then **Word document with Track Changes** in the Home tab (or quick access toolbar or File menu).

2. Select whether you want to save the comparison as a new document or attach it to the original or modified documents.

3. Click **OK**. The NetDocuments **Save As** dialog is displayed.

4. Browse to the location where you want to save the track change document and modify the name of the document as required.
5. Click **Save**. The redline is saved as a Microsoft Word document with the changes indicated by track changes.

When you open the saved file in Microsoft Word, the changes are displayed as track changes.

**Opening saved Workshare DeltaFiles**

When a comparison has been saved as a Workshare DeltaFile, you can open it from Workshare Compare.

**To open a saved comparison:**

1. Click **Open Comparison** from the File menu. An *Open* dialog is displayed.

   **Note:** Clicking *Open* when you work with a DMS/CRM or SharePoint accesses the DMS/CRM or SharePoint. To open from a local or network drive, hold the Shift key down when clicking *Open* or click *Cancel* in the DMS/CRM or SharePoint open dialog.

2. Navigate to the location where the comparison is saved and select the WDF file you want to open.

3. Click *Open*. The selected comparison is opened in Workshare Compare. The source documents and the redline are displayed as well as any ‘Accepted’ and ‘Flagged’ selections you made in the Change Summary window.

**Saving redlines to Workshare online**

If you work with Workshare online, you can save redlines there so they will be accessible to you online at all times.

You can save the redline as a Workshare DeltaFile (WDF), which contains all three documents (original, modified and redline) as well as your ‘Accept’ and ‘Flag’ selections. You can also save just the redline as a DOC/DOCX, RTF, HTM, TXT or PDF file or you can save the redline as a track change document.

**Note:** You can also use Save As and save the redline to your Workshare sync folder and it will be synchronized to Workshare online. Refer to Adding files to Workshare.
To save the redline to Workshare online:

1. Click **Save to My Files** and then **As Comparison document** in the **Home** tab (or File menu). The **Save to My Files** dialog is displayed.

   ![Save to My Files dialog](image)

   - **Create new folder**
   - **My Files**: Work in Progress, SSO, Private, Draft Contracts
   - **File name**: Sample Original Document - Sample Modified
   - **Save as type**: Adobe Acrobat File (*.pdf)

2. Browse through **My Files** and select the folder where you want to save the comparison.

   **Note**: To create a new folder, click **Create new folder**, enter a name for the folder and click **Create**.

3. In the **File name** field, modify the name of the comparison as required.
4. From the **Save as type** dropdown list, select the format for the saved file from the following:

- **Workshare DeltaFile (.wdf)**: Saves both the redline and the source documents, as well as your ‘Accept’ and ‘Flag’ selections, as a Workshare DeltaFile. This file can only be opened in Workshare Compare.

- **Word Document (.doc/*.docx)**: Saves the redline as a Microsoft Word file. The source documents and your ‘Accept’ and ‘Flag’ selections are not saved.

- **Text Only (.txt)**: Saves the redline as a text file. The source documents and your ‘Accept’ and ‘Flag’ selections are not saved.

- **Rich Text Format (.rtf)**: Saves the redline as an RTF file. The source documents and your ‘Accept’ and ‘Flag’ selections are not saved.

- **HTML Document (.htm)**: Saves the redline as a HTML document. The source documents and your ‘Accept’ and ‘Flag’ selections are not saved.

- **Adobe Acrobat File (.pdf)**: Saves the redline as a PDF file. The source documents and your ‘Accept’ and ‘Flag’ selections are not saved.

- **Adobe Acrobat PDF/A File (.pdf)**: Saves the redline as a PDF/A file. The source documents and your ‘Accept’ and ‘Flag’ selections are not saved.

5. Click **Save**.

### Saving to Workshare online as track change document

You can also save the redline to Workshare online as a Microsoft Word file that shows the changes as track changes.

**Note:** The converting to track changes functionality is only enabled, if the Enable Convert to Track Change functionality parameter (Comparison > User Interface category) in the Workshare Configuration Manager is selected.

To save redlines to Workshare online with changes as track changes:

1. Click **Save to My Files** and then **As Word document with Track Changes** in the Home tab (or File menu).

2. In the **Save to My Files** dialog displayed, select a folder in My Files (or create a new one), specify a name for the track change document and click **Save**. The redline is saved as a Microsoft Word document with the changes indicated by track changes.
Sharing redlines to Workshare online

When you work with Workshare online, you can share redlines to groups there so you can collaborate on them with others.

You can share the redline as a PDF file or you can share the redline as a track change document.

**Note:** You can also use Save As and save the redline to a group folder in your Workshare sync folder and it will be synchronized to Workshare online. Using this method, you could share the entire comparison, including the source files and your ‘Accept’ and ‘Flag’ selections as a WDF file. Refer to Adding files to Workshare.

To share the redline to Workshare online:

1. Click **Share** and then **As Comparison document** in the **Home** tab (or File menu). The **Share** dialog is displayed.
2. Enter the name of the group you want to share the redline with. As you start to enter the name, groups are suggested to you.

3. Select a group or enter a new group name and click **Create a new group**.

4. Edit the name of the redline by clicking ✎, modifying the name and then clicking ✓.

5. Click **Share**. The redline is saved to the group in Workshare online and a confirmation dialog is displayed.
6. Continue in one of the following ways:
   - Click **Send email** to open a new email in Outlook that includes a link to the redline in Workshare online. You can invite people to the group by sending the email to them.
   - Click **Go to group** to open the group in Workshare online where you can see the redline and set group permissions and members.

   **Note:** Click ☑️ to copy the link to the redline to your clipboard. You can then paste this link to another location, for example, an email or an instant message.

**Sharing to Workshare online as track change document**

You can also share the redline to Workshare online as a Microsoft Word file that shows the changes as track changes.

**Note:** The converting to track changes functionality is only enabled, if the Enable Convert to Track Change functionality parameter (Comparison > User Interface category) in the Workshare Configuration Manager is selected.

**To share redlines to Workshare online with changes as track changes:**

Click **Share** and then **as Word document with Track Changes** in the Home tab (or File menu). The redline is saved as a Microsoft Word document with the changes indicated by track changes and shown in the Share dialog as a DOCX file. Complete the share process as described in the procedure above.

**Sending by email**

Workshare Compare integrates with your email system so you can send the redline as well as the original and modified documents as email attachments. You can send the entire redline or just the pages that include changes. You can also send the redline as a Microsoft Word file that shows the changes as track changes. This is useful if the recipient does not have Workshare Compare.

**To send a redline as a PDF:**

Click **Email** and then **Attach as PDF** in the Home tab (or File menu). The redline is converted to PDF and a new email window is opened with the PDF attached.

**To send changed pages as a PDF:**

Click **Email** and then **Attach as PDF (only pages with changes)** in the Home tab (or File menu). The changed pages in the redline are converted to PDF and a new email window is opened with the PDF attached.
To send source documents with the redline:

1. Click Email and then More email options in the Home tab (or File menu). The Email Comparison Documents dialog is displayed.

   ![Email Comparison Documents dialog]

   **Select the documents to attach to a new email message**

   - Individual documents included in this comparison
   - Workshare 9's internal file format (DeltaFile)

   **Document Type** | **Document Name** | **Document Format**
   -----------------|------------------|------------------
   Redline Document   | Sample Original Document | Adobe Acrobat File (*.pdf)

   Only include pages with changes in Redline (PDF only)

   ![Email Comparison Documents dialog]

2. Select the files to send by selecting one of the following options:
   - **Individual documents included in this comparison**

     Selecting this option displays a list of the documents included in the comparison in the lower pane. Select the checkboxes to the left of the documents you want to send. You can click in the Document Name fields and modify the names of the documents.

   **Note:** The original and modified documents are sent in Microsoft Word format and the redline is sent by default as a PDF. Click in the Document Format field of the redline to change the default format, for example, to RTF.
Comparing Documents

- **Workshare Compare’s internal file format (DeltaFile)**
  Selecting this option sends the compared documents as a DeltaFile which contains all three documents (original, modified and redline) as well as your ‘Accept’ and ‘Flag’ selections. A DeltaFile can only be opened in Workshare Compare. The file extension for a DeltaFile is WDF.

<table>
<thead>
<tr>
<th>Document Type</th>
<th>Document Name</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Workshare DeltaFile" /></td>
<td>Sample Original Documen</td>
</tr>
</tbody>
</table>

**Tip! Click in the Document Name field to change the name of the redline.**

3. If you only want to include the pages with changes in the redline, select the **Only include pages** checkbox. This is only available when you are sending the redline as a PDF.

4. Click **OK**. An email message window is displayed with the selected files as attachments.

5. Enter the recipient(s) name and any other text you want to include and click **Send**.

**Sending by email as track change document**

You can also send the redline as a Microsoft Word file that shows the changes as track changes.

**Note:** The converting to track changes functionality is only enabled, if the **Enable Convert to Track Change functionality** parameter (Comparison > User Interface category) in the Workshare Configuration Manager is selected.

**To send redlines with changes as track changes:**

Click **Email** and then **Attach as Word document with Track Changes** in the **Home** tab (or File menu). The redline is saved as a Microsoft Word document with the changes indicated by track changes and a new email window is opened with the Word document attached.

**Printing redlines**

You can print the entire redline or just the pages that have changes, as well as either of the source documents.

**To print the comparison documents:**

1. Click **Print** in the **Home** tab (or File menu) and then one of the following options:
   - **Comparison only**
   - **Comparison + Modified**
   - **Comparison + Modified + Original**
The *Print* dialog is displayed.

![Print dialog](image)

2. Select from the standard print options in the usual way.

3. If you are printing to a black and white printer, select the **Print Redline in black and white** checkbox, as color text may not appear clearly when printing in black and white.

4. If you only want to print pages of the redline that include changes, select the **Only print pages with changes** checkbox.

5. Click **OK**.

**Note:** You can preview the printed version of the redline, original or modified document using the *Print Preview* options in the File menu.
Converting redline to PDF
You can convert the redline to PDF and save it locally or in your DMS or you can attach the PDF to an email and send.

To convert a redline to PDF:
1. Click PDF in the Home tab. The Convert to PDF dialog is displayed.

2. Select whether you want to convert the redline to PDF or PDF/A.
3. If required, click **Configure PDF Security** to set PDF security options as well as metadata cleaning options. The following dialog is displayed.

![PDF security configuration dialog](image)

- **Prevent printing**: Prevents recipients from printing the PDF document.
- **Prevent editing of text**: Prevents recipients with Adobe Distiller from editing the PDF document.
- **Prevent the copying of text and/or graphics**: Prevents recipients from copying graphics or text directly from the PDF document.
- **Prevent comments being added**: Prevents recipients with Adobe Distiller from adding comments to the PDF document.

4. If you selected **PDF**, you can select one or more of the security options as required:
   - **Prevent printing**: Prevents recipients from printing the PDF document.
   - **Prevent editing of text**: Prevents recipients with Adobe Distiller from editing the PDF document.
   - **Prevent the copying of text and/or graphics**: Prevents recipients from copying graphics or text directly from the PDF document.
   - **Prevent comments being added**: Prevents recipients with Adobe Distiller from adding comments to the PDF document.
5. If you selected PDF or PDF/A, click Cleaning Options to specify what metadata to remove before converting the redline to PDF.

6. Select metadata elements as required. For a full description of all the metadata elements, refer to the Workshare Professional User Guide.

7. Click OK.

8. If you selected PDF, you can set a password to protect the PDF by entering the password twice in the Password protection area. When a password is specified, the recipient can only open the PDF after entering this password.

9. Click Apply.

10. In the Convert to PDF dialog, when working with a DMS, select whether to save the PDF as a new document or as a related document or locally.
11. If you want to create a PDF of part of the redline only, select the **Pages** radio button and specify a page range.

*Note:* You can also PDF individual pages by specifying the pages (separated by commas) in the **Pages** field.

12. If required, click **Preview** to view the document as a PDF.

13. To open the PDF once it has been created, select the **Open PDF once created** checkbox.

14. To attach the PDF to a new email message once it has been created, select the **Email PDF as an attachment** checkbox.

15. Click **Create**. The **Save as** dialog is displayed.

16. Specify the name and location for the PDF file and click **Save**. The redline is converted to PDF.
Chapter 3: Comparing Presentations

This chapter describes Workshare Compare for PowerPoint, a standalone application that enables you to compare two presentations. It includes the following sections:

- **Introducing Compare for PowerPoint**, page 73, introduces the Workshare Compare for PowerPoint application and explains how to launch it.

- **Comparing Presentations**, page 73, describes how to compare a presentation against an earlier version of the presentation or against a different presentation using Workshare Compare for PowerPoint.

- **Workshare Compare for PowerPoint Main Window**, page 80, describes the Workshare Compare for PowerPoint environment and provides an overview of the functionality available.

- **Working with Comparisons**, page 86, describes the tools available to you when working with the compared presentation after a comparison.
Introducing Compare for PowerPoint

Note: This chapter describes how to compare PowerPoint presentations. The comparison of Word documents and PDF files is described in Chapter 2 and the comparison of Excel spreadsheets is described in Chapter 4.

Workshare Compare for PowerPoint is a presentation comparison tool designed to make the process of editing and revising presentations as fast and efficient as possible. Workshare Compare for PowerPoint enables you to compare Microsoft PowerPoint presentations and immediately see any differences between them. In one view, you can see both the original and modified presentations with the differences clearly marked as well as a written summary of the changes and color-coded thumbnails of the slides showing which slides were modified, deleted, and inserted. Presentations stored in your DMS or CRM, locally or on your network can be compared.

To make the review easier, you can select different “comparison themes” to define exactly what is compared as well as how changes are displayed.

What is compared?

Workshare Compare for PowerPoint provides a comprehensive comparison of two Microsoft PowerPoint presentations and can detect the following changes:

- Slide moves, insertions and deletions
- Text moves, insertions and deletions
- Text formatting changes
- Image and object content changes
- Text box changes
- Hyperlink changes
- Speaker note changes
- Slide background changes

Comparing Presentations

You can compare your original presentation against a previous version of the presentation or against another presentation entirely. For example, there may be ten versions of a presentation in your DMS. You can open version 10 and compare it against version 5.

You can launch Workshare Compare for PowerPoint and perform comparisons from within Microsoft Word, from your desktop, from right-click options or from an email and each of these scenarios is described in the following sections.
Launching PowerPoint comparisons from Microsoft PowerPoint

In this scenario, you first open your presentation in Microsoft PowerPoint.

To compare presentations:

Click Compare in the Workshare tab. The Select Presentations for Comparison dialog is displayed with the open presentation in the Modified Presentation field. Select the presentation to compare it against as described in Launching PowerPoint comparisons from your desktop.

Launching PowerPoint comparisons using right-click options

You can launch Workshare Compare for PowerPoint by right-clicking presentations in File Explorer or in your DMS (iManage FileSite/DeskSite and OpenText).

- Right-click the original presentation and select Compare with Workshare. The Select Presentations for Comparison dialog is displayed with the selected presentation in the Original Presentation field. Select the file to compare it against as described in Launching PowerPoint comparisons from your desktop.

- Select the original and modified presentations, right-click and select Compare with Workshare. The Select Presentations for Comparison dialog is displayed with the selected presentations in the Original Presentation and Modified Presentation fields. Continue as described in Launching PowerPoint comparisons from your desktop.

Note: You cannot launch Workshare Compare for PowerPoint from SharePoint or Worldox using right-click options, from NetDocuments using Send to Application, or from the iManage Work 10 browser interface using the kebab (context) menu.
Launching PowerPoint comparisons from email

You can launch Workshare Compare for PowerPoint from the dropdown context menu of an attachment to an email or using the Compare button in the Workshare tab.

- Select one (or two attachments), click the dropdown and click **Compare with Workshare**.

The **Select Presentations for Comparison** dialog is displayed with the attachment in the **Modified Presentation** field. Continue as described in *Launching PowerPoint comparisons from your desktop*.

- With an email selected in your inbox, click **Compare** in the **Workshare** tab. If the email doesn’t include attachments, the **Compare** button is disabled. If the email includes one or two PowerPoint attachments, the **Select Presentations for Comparison** dialog is displayed with the attachments selected. If the email contains more than two attachments, the following dialog is displayed:
Select the attachments you want to compare and click **Continue**. The **Select Presentations for Comparison** dialog is displayed with the attachments selected. Continue as described in **Launching PowerPoint comparisons from your desktop**.

**Note**: If you select attachments that can’t be compared for example, a DOCX and an PPTX, the **Continue** button will be disabled.

## Launching PowerPoint comparisons from your desktop

In this scenario, you launch Workshare Compare for PowerPoint as a standalone application from your desktop or the Start menu. You then select the presentations you want to compare.

**To compare presentations:**

1. Double-click the Workshare Compare for PowerPoint shortcut on your desktop or select **Workshare Compare for PowerPoint** from the Start menu. The **Select Presentations for Comparison** dialog is displayed:

   ![Select Presentations for Comparison dialog](image)

   Select the presentations that you would like to compare.

   **Original Presentation:**

   **Modified Presentation:**

   **Select Comparison Theme:**

   This comparison theme will ignore changes to: images, embedded objects, item locations, text formatting, text box formatting, slide backgrounds, hyperlink destinations, autoshapes.
Comparing Presentations

**Note:** Click **Cancel** if you want to close the Select Presentations for Comparison dialog without running a comparison. For example, if you just want to open the Workshare Compare for PowerPoint window in order to open a previously saved comparison.

2. Select the original presentation you want to compare:
   - Drag the file over the **Original Presentation** field, or
   - Click to the right of the **Original Presentation** field, navigate to the presentation location in your local file system, SharePoint or DMS/CRM and click **Open**.

   The selected presentation is displayed in the **Original Presentation** field.

   **Tip!** If you want to compare a recently used file, click the dropdown ▼ in the **Original Presentation** and **Modified Presentation** fields and select the presentations you want to compare. These lists contain the last 8 files you have used.

3. Select the presentation you want to compare with the original presentation:
   - Drag the file over the **Modified Presentation** field, or
   - Click to the right of the **Modified Presentation** field, navigate to the presentation location in your local file system, SharePoint or DMS/CRM and click **Open**.

   The selected presentation is displayed in the **Modified Presentation** field.

   **Tip!** To swap the original and modified presentations, click ▼.

4. From the **Select Comparison Theme** dropdown list, select the comparison theme you want to use. Comparison themes contain a set of parameters that define exactly what is compared as well as how changes are displayed. You can select from the standard comparison themes provided with Workshare Compare for PowerPoint or you can create and customize your own comparison themes. Refer to Appendix B: Configuring Comparison Themes for further information.

   **Note:** Clicking ▼ to the right of the **Select Comparison Theme** field displays the Comparison Themes Manager where you can create, modify and delete comparison themes. For a full description refer to Appendix B: Configuring Comparison Themes.
5. Click **OK**. The comparison process is launched and a progress dialog is displayed. When the comparison is complete, the Workshare Compare for PowerPoint window is displayed showing the changes between the selected presentations. For a full description of the Workshare Compare for PowerPoint interface, refer to *Workshare Compare for PowerPoint Main Window*. For a description of how to navigate between the changes and review the changes in your compared presentations, refer to *Working with Comparisons*.

**Workshare Compare for PowerPoint from the command line**

Comparisons can be run from the command line. Running `DeckCompare.exe /?` displays a summary of the available command line options when the program starts up.

The command line parameters are as follows:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>/load &lt;file&gt;</td>
<td>Loads an existing comparison file (*.wcfp).</td>
</tr>
<tr>
<td>/original &lt;file&gt;</td>
<td>Selects an existing original presentation file for comparison.</td>
</tr>
<tr>
<td>/modified &lt;file&gt;</td>
<td>Selects an existing modified presentation file for comparison.</td>
</tr>
<tr>
<td>/theme &lt;name&gt;</td>
<td>Selects the named comparison theme.</td>
</tr>
</tbody>
</table>
Comparing Presentations

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>/save&lt;file&gt;</td>
<td>For an initial comparison from the command line, specifies a file to save the comparison to.</td>
</tr>
<tr>
<td>/report &lt;file name&gt;</td>
<td>Creates a report of the comparison that includes the original and modified slide as well as a list of the changes per slide pair.</td>
</tr>
<tr>
<td>/showselector</td>
<td>Displays the Select Presentations for Comparison dialog enabling you to perform a new comparison.</td>
</tr>
<tr>
<td>/resetwindowlayout</td>
<td>Displays the main window in its default layout.</td>
</tr>
<tr>
<td>/noapply</td>
<td>Turns off the apply change functionality for the comparison.</td>
</tr>
<tr>
<td>/?</td>
<td>Shows the command line options.</td>
</tr>
</tbody>
</table>

If /load is used, or both /original and /modified, the Select Presentations for Comparison dialog is bypassed. Otherwise, the dialog is pre-populated with whichever of /original, /modified and /theme are specified.
Workshare Compare for PowerPoint Main Window

The Workshare Compare for PowerPoint main window enables you to view the results of a comparison between an original presentation and a modified presentation. You can view (in one work area) both source presentations, slide thumbnails and a summary of the changes between the two source presentations.

The ribbon changes according to the selected tab. In the above example, the Home tab is selected so the Home ribbon is displayed.

The different areas of the Workshare Compare for PowerPoint work area are described in the following sections.
## File menu

The File menu includes the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open</td>
<td>Enables you to open a saved comparison. Comparisons are saved as Workshare .wcfp files. Refer to Opening saved Workshare Compare for PowerPoint files.</td>
</tr>
<tr>
<td>Save</td>
<td>Enables you to save the current comparison. Refer to Saving comparisons.</td>
</tr>
<tr>
<td>Save As</td>
<td>Enables you to save a saved comparison with a new name.</td>
</tr>
<tr>
<td>Print</td>
<td>Enables you to print a comparison report showing the changes found by the comparison. Refer to Printing comparison reports.</td>
</tr>
<tr>
<td>About</td>
<td>Displays version information about Workshare Compare for PowerPoint.</td>
</tr>
<tr>
<td>Exit</td>
<td>Closes Workshare Compare for PowerPoint.</td>
</tr>
</tbody>
</table>

## Quick access toolbar

The quick access toolbar provides one-click access to functionality. By default, the Save and New buttons are available. Click the arrow to the right of the quick access toolbar and select Minimize the Ribbon to hide the ribbon.

**Note:** To change the commands that appear in the quick access toolbar, right-click in the ribbon and select Customize Quick Access Toolbar.

## Home tab

The Home ribbon enables you to move between slides and changes, as well as apply and edit comparison themes.
The options are described in the following table.

<table>
<thead>
<tr>
<th>Section</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Comparison</strong></td>
<td>New</td>
<td>Opens the <em>Select Presentations for Comparison</em> dialog enabling you to perform a new comparison. Refer to <em>Comparing Presentations</em>.</td>
</tr>
<tr>
<td><strong>Reports</strong></td>
<td>Print</td>
<td>Enables you to print a comparison report showing the changes found by the comparison. Refer to <em>Printing comparison reports</em>.</td>
</tr>
<tr>
<td></td>
<td>Create</td>
<td>Enables you to create a comparison report showing the changes found by the comparison. Refer to <em>Creating comparison reports</em>.</td>
</tr>
<tr>
<td><strong>Change</strong></td>
<td>Show</td>
<td>Displays only slides that include changes, hiding those slides that have not changed.</td>
</tr>
<tr>
<td><strong>Navigation</strong></td>
<td>Changes</td>
<td>Displays/hides the Change Summary area. Refer to <em>Change Summary area</em>.</td>
</tr>
<tr>
<td><strong>Change</strong></td>
<td>Summary</td>
<td>Displays only changes relating to the currently displayed slide in the Change Summary area.</td>
</tr>
<tr>
<td><strong>Current Slide</strong></td>
<td>Only</td>
<td>Displays only changes relating to the currently displayed slide in the Change Summary area.</td>
</tr>
<tr>
<td><strong>Find Change</strong></td>
<td></td>
<td>Enables you to search for specific text in the Change Summary area. Refer to <em>Searching changes</em>.</td>
</tr>
<tr>
<td><strong>Previous</strong></td>
<td></td>
<td>Navigates to the previous change in the Change Summary area. The change in also highlighted in the Slide View area. Refer to <em>Navigating between changes</em>.</td>
</tr>
<tr>
<td><strong>Next</strong></td>
<td></td>
<td>Navigates to the next change in the Change Summary area. The change in also highlighted in the Slide View area. Refer to <em>Navigating between changes</em>.</td>
</tr>
<tr>
<td><strong>First</strong></td>
<td></td>
<td>Navigates to the first change in the Change Summary area. The change in also highlighted in the Slide View area. Refer to <em>Navigating between changes</em>.</td>
</tr>
<tr>
<td><strong>Last</strong></td>
<td></td>
<td>Navigates to the last change in the Change Summary area. The change in also highlighted in the Slide View area. Refer to <em>Navigating between changes</em>.</td>
</tr>
<tr>
<td><strong>Comparison</strong></td>
<td>Select</td>
<td>Enables you to select an alternative comparison theme from the dropdown list. This comparison theme is then applied to the current comparison. Refer to <em>Applying Comparison Themes</em>.</td>
</tr>
<tr>
<td></td>
<td>Edit</td>
<td>Opens the Comparison Themes Manager from where you can modify existing comparison themes as well as create new comparison themes. Refer to <em>Customizing Comparison Themes</em>.</td>
</tr>
</tbody>
</table>
More tab

The More ribbon enables you to change the display of the different areas in the main window.

![More ribbon options](image)

The options are described in the following table.

<table>
<thead>
<tr>
<th>Section</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Original/Modified</td>
<td>Swap</td>
<td>Swaps the original and modified presentations and re-runs the comparison. Refer to <em>Swapping the source files</em>.</td>
</tr>
<tr>
<td>Slide/Views</td>
<td>Horizontal</td>
<td>Displays the original and modified presentations side by side in the Slide View area.</td>
</tr>
<tr>
<td></td>
<td>Vertical</td>
<td>Displays the original presentation above the modified presentation in the Slide View area.</td>
</tr>
<tr>
<td></td>
<td>Tabbed</td>
<td>Displays the original and modified presentations in tabs in the Slide View area.</td>
</tr>
<tr>
<td>Zoom</td>
<td>Zoom</td>
<td>Enables you to change the magnification of the original and modified presentations in the Slide View area. There are also zoom controls on the right side of the status bar.</td>
</tr>
<tr>
<td></td>
<td>Fit Width</td>
<td>Fits the original and modified presentations to the width of the Slide View area.</td>
</tr>
</tbody>
</table>

Slide Selector area

The Slide Selector area displays thumbnail images of the slides in the original and modified presentations. The slides have different colored borders so you can see at a glance when a new slide has been inserted or a slide has been deleted or includes changes. The border colors are as follows:

- **Yellow** The content of the slide has changed.
- **Green** The slide has moved its position (the new position is indicated).
- **Red** The slide has been deleted.
- **Blue** The slide is a new inserted slide.

Slides that have not changed in any way have no colored border.
In addition, the following icons in between the slide pairs indicate which slide pairs are different and which are the same:

- 😊 Both slides in the slide pair are the same.
- 📡 There are differences between the slides in the slide pair.

The slides currently selected in the Slide Selector area are displayed in the Slide View area.

The Slide Selector area is by default positioned down the left side of the Workshare Compare for PowerPoint environment. It can also float over the other windows. Click the ⬇️ and select from the following options:

| Floating | Dockable | Tabbed Document | Auto Hide | Hide |

**Tip! You can also use the ⬇️ to auto-hide the Slide Selector area.**

**Slide View area**

The Slide View area displays both presentations that have been compared and clearly indicates the changes on each. The presentations are synchronized so that if you select a particular slide in the Slide Selector area or a particular change in the Change Summary area then that slide or change is shown in both the original and modified presentations.

Changes are marked according to the comparison theme applied to the comparison. For example, deleted text could be **red and struck through** and added text could be **blue and underlined**.
Change Summary area

The Change Summary area provides a list of all the changes between the original and modified presentations in the order that they occur. Changes can be displayed for all slides or on a slide by slide basis. Selecting a change in the Change Summary area displays the slides that include the change in the Slide View area and highlights the slides in the Slide Selector area. The change that is selected is highlighted in light green in the Slide View area.

The color and formatting of the change in the Change Summary area and in the Slide View area is determined by the comparison theme applied to the comparison. For a full description of comparison themes, refer to Appendix B: Configuring Comparison Themes.

You can select changes in the Change Summary area using the mouse or using buttons in the Home tab.

The following information is shown for each change in the Change Summary area:

<table>
<thead>
<tr>
<th><strong>Slide Number</strong></th>
<th>The number of the original slide and the number of the modified slide in the comparison.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Change Numbers</strong></td>
<td>The number of the change in the comparison. A change may have two numbers when it includes two actions. For example, a deletion and an addition.</td>
</tr>
<tr>
<td><strong>Type</strong></td>
<td>The type of change, such as replaced text, deleted text box, moved slide.</td>
</tr>
<tr>
<td><strong>Details</strong></td>
<td>Details of the change.</td>
</tr>
</tbody>
</table>

The icons to the left of each change indicate the type of change as follows:

- **Replacements**
- **Formatting changes**
- **Insertions**
- **Slide move source**
- **Deletions**
- **Slide move destination**

The Change Summary area is by default positioned across the bottom of the Workshare Compare for PowerPoint environment. It can also float over the other windows. Click the and select from the following options:

- **Floating**
- **Dockable**
- **Tabbed Document**
- **Auto Hide**
- **Hide**

**Tip!** You can also use the to auto-hide the Change Summary area.
Working with Comparisons

Navigating changes

After performing a comparison, you can review the result of the comparison and consider the changes between the original and modified presentations. You can move between changes by navigating between slides or by navigating between changes. All areas of the Workshare Compare for PowerPoint window are synchronized.

Navigating between slides

Clicking slides in the Slide Selector area displays the selected slides in the Slide View area and shows the changes relating to that slide in the Change Summary area.

The following icons in between the slide pair in the Slide Selector area indicate whether the slide has changed or not:

- The slide has not changed.
- The slide has changed.

In addition, the thumbnail images of the slides in the Slide Selector area have different colored borders so you can see at a glance when a new slide has been inserted or a slide has been deleted or a slide includes changes. The border colors are as follows:

- **Yellow**: The content of the slide has changed.
- **Green**: The slide has moved its position (the new position is indicated).
- **Red**: The slide has been deleted.
- **Blue**: The slide is a new inserted slide.

Slides that have not changed in any way have no colored border.
Navigating between changes

Clicking a change in the Change Summary area displays the slides that include the change in the Slide View area and highlights the slides in the Slide Selector area. The change that is selected is highlighted in light green in the Slide View area.

The color and formatting of the change in the Change Summary area and in the Slide View area is determined by the comparison theme applied to the comparison. For a full description of comparison themes, refer to Appendix B: Configuring Comparison Themes.

You can also move between changes in the Change Summary area using the First, Last, Previous and Next buttons in the Change Navigation group of the Home tab.

**Note:** By default, the Change Summary area provides a list of all changes occurring on all slides in the compared presentations. If you want to display just the changes that occur on the displayed slide, click the Current Slide Only button in the Change Navigation group of the Home tab.

The Change Summary area indicates the type of change as well as details of the change itself, such as the specific text that has been inserted or deleted.
Searching changes

You can search for specific text in the Change Summary area. Workshare Compare for PowerPoint can search all text in the Change Summary area or just the text that has been changed (inserted, deleted or moved).

To search changes:

1. Click the **Find Change** button in the **Change Summary** group of the Home tab. The **Find Changes** dialog is displayed.

2. In the **Find what** field, enter the text that you want to look for.

3. Select the **Match case** checkbox if you want to search for identical text in the same case.

4. Select the **Search changed text only** checkbox if you want to search only the text that has been changed.

5. Click **Find**. Workshare Compare for PowerPoint searches for the specified text. When it is found, the text is highlighted in the Change Summary area and the relevant slide is shown in the Slide Selector area and Slide View area.

6. Click **Find Next** to search for further occurrences of the specified text. Click **Find Previous** to return to the previously found instance.

7. Click **Close** to close the **Find Changes** dialog.
Swapping the source files

You can re-run a comparison exchanging the original presentation for the modified presentation and vice versa. For example, if you selected Presentation A as the original presentation and Presentation B as the modified presentation, Workshare Compare for PowerPoint shows the changes made to Presentation A to produce Presentation B. You can then swap the presentations so that Presentation B is now the original and Presentation A is the modified presentation. Workshare Compare for PowerPoint automatically re-runs the comparison and shows the changes made to Presentation B to produce Presentation A.

To swap the source presentations:
Click Swap in the More tab. Workshare Compare for PowerPoint automatically runs a new comparison, using the modified presentation as the original presentation and the original presentation as the modified presentation. The new comparison is displayed in the Workshare Compare for PowerPoint window replacing the previous comparison.

Saving comparisons

You can save a comparison as a Workshare Compare for PowerPoint file (.wcfp) in your DMS or CRM, locally or on your network. This file type can be opened in Workshare Compare for PowerPoint.

To save a comparison:
1. Click Save in the File menu or quick access toolbar. The Save As dialog is displayed.
2. Navigate to the location where you want to save the file and enter a name for the file.
3. Click Save.

Note: If you work with Workshare online, you can also use Save As and save the comparison to your Workshare sync folder and it will be synchronized to Workshare online. Refer to Adding files to Workshare.

Opening saved Workshare Compare for PowerPoint files

When a comparison has been saved as a Workshare Compare for PowerPoint file, you can open it from the Workshare Compare for PowerPoint main window.
To open a saved comparison:

1. Click Open in the File menu. An Open dialog is displayed.

   **Note:** If Workshare Compare for PowerPoint is not open, launch it in the usual way and click Cancel in the Select Presentations for Comparison dialog so that no initial comparison is performed and a blank Workshare Compare for PowerPoint main window is displayed.

2. Navigate to the location where the comparison is saved and select the .wcfp file you want to open.

3. Click Open. The selected comparison is opened in Workshare Compare for PowerPoint.

Creating comparison reports

After you have run a comparison, you can create a report showing the changes found by the comparison. The PDF comparison report can include both the original and modified slides as well as a list of changes per slide pair or you can select to include just the slide pair or just the list of changes.

To create a comparison report:

1. Click Create in the Home tab. The Create Comparison Report dialog is displayed.

2. In the Choose Report Layout area, select what you want to include in the report by selecting one of the following options:
   - **Full Comparison Report**: Includes the original and modified slide as well as a list of the changes per slide pair.
Comparing Presentations

- **Change Summary Only**: Includes the list of changes in table format for each slide pair.
- **Slide View Only**: Includes the original and modified slides.

3. Select the **Exclude Unchanged Slides from Report** checkbox if you only want to include slides with changes in the report.

**Note:** To display the selected comparison report, click **Preview**.

4. Click **Create**.
5. In the save dialog, browse to a save location and enter a name for the report.
6. Click **Save**. The comparison report is generated and saved as a PDF in the specified location.

**Printing comparison reports**

After you have run a comparison, you can print a report showing the changes found by the comparison. The comparison report can include both the original and modified slides as well as a list of changes per slide pair or you can select to include just the slide pair or just the list of changes.

If you have created a comparison report already and saved it as a PDF (as described in Creating comparison reports) you can simply print the PDF in the usual way. The following procedure describes how to create and print a comparison report in one step.

**To print a comparison report:**

1. Click **Print** in the Home tab or File menu. The **Print Comparison Report** dialog is displayed.
2. In the **Choose Report Layout** area, select what you want to include in the report by selecting one of the following options:
   - **Full Comparison Report**: Includes the original and modified slide as well as a list of the changes per slide pair.
   - **Change Summary Only**: Includes the list of changes in table format for each slide pair.
   - **Slide View Only**: Includes the original and modified slides.
3. Select the **Exclude Unchanged Slides from Report** checkbox if you only want to include slides with changes in the report.
4. In the **Printer** area, select which printer to use.
5. In the **Print Range** area, select whether to include all slides or selected slides.
6. In the **Copies** area, enter how many copies of the comparison report you want to print and select the **Collate** checkbox if collating of multiple copies is required.
Note: To display the selected comparison report, click Preview. Note that the full report is displayed for preview even if a page range has been specified.

7. Click OK. The comparison report is created and printed as specified.
Chapter 4: Comparing Spreadsheets

This chapter describes Workshare Compare for Excel, a standalone application that enables you to compare two spreadsheets. It includes the following sections:

- **Introducing Compare for Excel**, page 94, introduces the Workshare Compare for Excel application and explains how to launch it.

- **Comparing Spreadsheets**, page 94, describes how to compare a spreadsheet against an earlier version of the spreadsheet or against a different spreadsheet using Workshare Compare for Excel.

- **Workshare Compare for Excel Main Window**, page 100, describes the Workshare Compare for Excel environment and provides an overview of the functionality available.

- **Understanding Changes**, page 103, describes how changes are displayed in the comparison.

- **Working with Comparisons**, page 109, describes the tools available to you when working with the compared spreadsheet after a comparison.
Introducing Compare for Excel

Note: This chapter describes how to compare Excel spreadsheets. The comparison of Word documents and PDF files is described in Chapter 2 and the comparison of PowerPoint presentations is described in Chapter 3.

Workshare Compare for Excel is a spreadsheet comparison tool designed to make the process of editing and revising spreadsheets as fast and efficient as possible. Workshare Compare for Excel enables you to compare Microsoft Excel spreadsheets and immediately see any differences between them. The differences between each cell are clearly marked and a detailed summary of the change provided in a panel. Spreadsheets stored in your DMS or CRM, locally or on your network can be compared.

What is compared?

Workshare Compare for Excel provides a comprehensive comparison of two Microsoft Excel presentations and can detect the following changes:

- Cell insertions and deletions
- Cell merges and splits
- Changes to number values
- Text changes
- Changes to formulas
- Number format changes
- Changes to visual formatting in cells
- Changes to font formatting

Comparing Spreadsheets

You can compare your original spreadsheet against a previous version of the spreadsheet or against another spreadsheet entirely. For example, there may be ten versions of a spreadsheet in your DMS. You can open version 10 and compare it against version 5.

You can launch Workshare Compare for Excel and perform comparisons from your desktop, from right-click options or from an email and each of these scenarios is described in the following sections.
Comparing Presentations

Launching Excel comparisons using right-click options

You can launch Workshare Compare for Excel by right-clicking presentations in File Explorer or in your DMS (iManage FileSite/DeskSite and NetDocuments).

- Right-click the original spreadsheet and select **Compare with Workshare**. The file selection dialog is displayed with the selected spreadsheet in the **Original** field. Select the file to compare it against as described in *Launching Excel comparisons from your desktop*.

- Select the original and modified spreadsheets, right-click and select **Compare with Workshare**. The file selection dialog is displayed with the selected spreadsheets in the **Original** and **Modified** fields. Continue as described in *Launching Excel comparisons from your desktop*.

**Note**: You cannot launch Workshare Compare for Excel from SharePoint, OpenText or Worldox using right-click options, or from the iManage Work 10 browser interface using the kebab (context) menu.

Launching Excel comparisons from email

You can launch Workshare Compare for Excel from the dropdown context menu of an attachment to an email or using the Compare button in the Workshare tab.

- Select one (or two attachments), click the dropdown and click **Compare with Workshare**.

![Spreadsheet drop-down context menu with Compare with Workshare option highlighted]

The file selection dialog is displayed with the selected spreadsheet in the **Modified** field. Continue as described in *Launching Excel comparisons from your desktop*. 
• With an email selected in your inbox, click **Compare** in the *Workshare* tab. If the email doesn’t include attachments, the **Compare** button is disabled. If the email includes one or two Excel attachments, the file selection dialog is displayed with the attachments selected. If the email contains more than two attachments, the following dialog is displayed:

![Select attachments dialog]

Select the attachments you want to compare and click **Continue**. The file selection dialog is displayed with the attachments selected. Continue as described in *Launching Excel comparisons from your desktop*.

**Note:** If you select attachments that can’t be compared for example, a DOCX and an XLSX, the **Continue** button will be disabled.

### Launching Excel comparisons from your desktop

In this scenario, you launch Workshare Compare for Excel as a standalone application from your desktop or the Start menu. You then select the spreadsheets you want to compare.
To compare spreadsheets:

1. Double-click the Workshare Compare for Excel shortcut on your desktop or select Workshare Compare for Excel from the Start menu. The file selection dialog is displayed:

   ![File Selection Dialog]

2. Select the original spreadsheet you want to compare:
   - Drag the file over the Original field, or
   - Click to the right of the Original field, navigate to the spreadsheet location in your local file system, SharePoint or DMS/CRM and click Open.

   The selected spreadsheet is displayed in the Original field.

   **Tip! If you want to compare a recently used file, drag the file from Recently opened files.**

3. Select the spreadsheet you want to compare with the original spreadsheet:
   - Drag the file over the Modified field, or
   - Click to the right of the Modified field, navigate to the spreadsheet location in your local file system, SharePoint or DMS/CRM and click Open.

   The selected spreadsheet is displayed in the Modified field.

   **Tip! To swap the original and modified spreadsheets, click .**
4. If you want to compare individual sheets, select the **Select sheets to compare** radio button.

5. Select the sheet in your original spreadsheet and the sheet in your modified spreadsheet that you want to compare.

6. Click **Compare**. The comparison process is launched.

When the comparison is complete, the Workshare Compare for Excel window is displayed showing the changes between the selected spreadsheets. For a full description of the Workshare Compare for Excel interface, refer to *Workshare Compare for Excel Main Window*. For a description of how to navigate between the changes and review the changes in your compared spreadsheets, refer to *Understanding Changes* and *Working with Comparisons*. 
Password-protected spreadsheets

Workshare can compare password-protected spreadsheets once you enter the password. After clicking Compare in the file selection dialog, you are prompted to enter the password for any password-protected files you have selected.

Enter the password for the spreadsheet and click Unlock. The comparison process is launched.
Workshare Compare for Excel Main Window

The Workshare Compare for Excel main window enables you to view the results of a comparison between an original spreadsheet and a modified spreadsheet.

File menu

The File menu includes the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>Opens the file selection dialog so you can start a new comparison. The existing open comparison will be closed. Refer to Comparing Spreadsheets.</td>
</tr>
<tr>
<td>Swap</td>
<td>Swaps the original and modified spreadsheets and re-runs the comparison. Refer to Swapping the source files.</td>
</tr>
</tbody>
</table>
### Home tab

The Home ribbon enables you to move between changes, as well as control what changes are shown.

<table>
<thead>
<tr>
<th>Section</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Comparison</strong></td>
<td>New</td>
<td>Opens the file selection dialog so you can start a new comparison. The existing open comparison will be closed. Refer to <em>Comparing Spreadsheets.</em></td>
</tr>
<tr>
<td></td>
<td>Swap</td>
<td>Swaps the original and modified spreadsheets and re-runs the comparison. Refer to <em>Swapping the source files.</em></td>
</tr>
<tr>
<td></td>
<td>Export</td>
<td>Enables you to save the current comparison as an Excel file showing the changes and including a change summary tab. Refer to <em>Saving comparisons.</em></td>
</tr>
<tr>
<td><strong>Style</strong></td>
<td>Show source formatting</td>
<td>Displays/hides the formatting applied to the original and modified spreadsheets, such as cell shades and font styles. Refer to <em>Source formatting.</em></td>
</tr>
<tr>
<td><strong>Change Type</strong></td>
<td>Show direct changes only</td>
<td>Displays/hides indirect changes. Indirect changes are changes that occur as the result of a modification to a different cell. Refer to <em>Direct and indirect changes.</em></td>
</tr>
<tr>
<td><strong>Change Type Filters</strong></td>
<td>Numbers</td>
<td>Displays/hides changes to number values.</td>
</tr>
<tr>
<td></td>
<td>Text</td>
<td>Displays/hides changes to text.</td>
</tr>
<tr>
<td></td>
<td>Formulas</td>
<td>Displays/hides changes to formulas.</td>
</tr>
<tr>
<td></td>
<td>Cell changes</td>
<td>Displays/hides whether cells have been inserted or deleted.</td>
</tr>
<tr>
<td>Section</td>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>--------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Cell merges</td>
<td>Displays/hides whether cells have been merged or split.</td>
</tr>
<tr>
<td></td>
<td>Number format</td>
<td>Displays/hides changes to the number format applied to a cell.</td>
</tr>
<tr>
<td></td>
<td>Cell format</td>
<td>Displays/hides changes to the visual formatting of a cell.</td>
</tr>
<tr>
<td></td>
<td>Font format</td>
<td>Displays/hides changes to the font formatting of a cell.</td>
</tr>
<tr>
<td>Change</td>
<td>Previous</td>
<td>Navigates to the previous change in the comparison. Refer to Navigate between changed cells.</td>
</tr>
<tr>
<td>Navigation</td>
<td>Next</td>
<td>Navigates to the next change in the comparison. Refer to Navigate between changed cells.</td>
</tr>
<tr>
<td></td>
<td>First change</td>
<td>Navigates to the first change in the comparison. Refer to Navigate between changed cells.</td>
</tr>
<tr>
<td></td>
<td>Last change</td>
<td>Navigates to the last change in the comparison. Refer to Navigate between changed cells.</td>
</tr>
<tr>
<td>Information</td>
<td>Legend</td>
<td>Displays a description of the meaning of the colors used in the comparison.</td>
</tr>
</tbody>
</table>

**Comparison area**

The comparison area clearly indicates the changes between the compared spreadsheets.

- Inserted cells, rows, columns are blue
- Indirect changes are green
- Direct changes are yellow
- Deleted cells, rows, columns are red

Selecting a cell displays details about its changes in the Change details panel on the right. You can select changes in the comparison using your mouse or the buttons in the Home tab.

When several sheets have been compared, you can select a worksheet using the tabs at the bottom of the comparison.
Change details panel

The change details panel is displayed to the right of the comparison when a cell is selected. It provides details about the changes in the selected cell.

Each change is listed in its own card in the panel. The change type is displayed at the top of the card.

You can close the change details panel by clicking the close icon in the top right.

Understanding Changes

Changes are shown using a combination of color, formatting and text description and Workshare offers several ways to filter changes to help make review of your changes as easy as possible.

Source formatting

Source formatting is any formatting applied to the original and modified files. It includes effects such as:

- Cell shades
- Cell colors
- Cell borders
- Non-standard fonts
- Font colors
- Font underlines
- Font styles (italic, bold)
- Font effects (strikethrough, superscript, subscript)
In the comparison, source formatting is turned off by default so it’s easier to see the changes.

<table>
<thead>
<tr>
<th></th>
<th>B</th>
<th>C</th>
<th>D</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jun-17</td>
<td>4538</td>
<td>138</td>
<td>1650</td>
</tr>
<tr>
<td>Jul-17</td>
<td>5581</td>
<td>145</td>
<td>1720</td>
</tr>
<tr>
<td>Aug-17</td>
<td>6625</td>
<td>105</td>
<td>2346</td>
</tr>
</tbody>
</table>

A comparison with source formatting off

The same comparison with source formatting on

To view the source formatting, click **Show source formatting** in the Home ribbon.

**Change types**

**Direct and indirect changes**

When a cell has changed, it can be useful to know if any other cells have also changed as a result.

Any change that has occurred as the result of a modification in the same cell is called a **direct change**. Any change that has occurred as the result of a modification to a different cell is called an **indirect change**.

For example, take a workbook that has a row full of formulas. If you insert a new row above the formula row, all the formulas are pushed down by one row. The change to these formulas is indirect. If you select one of the cells with a formula and modify the formula, the change is direct.
In a Workshare comparison, direct changes are highlighted yellow and indirect changes are highlighted green. You can see all changes to a cell by selecting the cell (see Changes to a cell).

**Note:** If a cell contains direct changes and indirect changes, it’s highlighted yellow.

Direct changes are always highlighted. Indirect changes are highlighted by default, but you can toggle them on and off by using the Show direct changes only button in the Home ribbon.

### Change type filters

The change type filters let you focus on the types of changes that matter to you. By default, every type of change is highlighted in the comparison. Switch off highlighting of individual change types by deselecting them in the Home ribbon.

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Numbers** | Cells with number values that have changed. For example, “1” has changed to “2”.  
**Note:** The number format of the cell can be any format, including General, Number, Text, Currency, etc. |
| **Text** | Cells with text values that have changed. For example, “January” has changed to “February”.  
Where cells include text and numbers (e.g. “A1” is changed to “B2”), they will be marked as Text changes. |
| **Formulas** | Cells with a formula that has changed. |
### Type

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Cell changes</strong></td>
<td>Cells that have been inserted or deleted. Inserted cells are highlighted blue. Deleted cells are highlighted red.</td>
</tr>
<tr>
<td><strong>Cell merges</strong></td>
<td>Cells that have been merged or split.</td>
</tr>
<tr>
<td><strong>Number format</strong></td>
<td>Cells that have had a change to their number format. For example, the number format has been changed from “General” to “Currency”. This includes changes to the properties of the number format. For example, a cell with the Currency format has had the number of decimal places changed from “2” to “0”.</td>
</tr>
<tr>
<td><strong>Cell format</strong></td>
<td>Cells that have had a change to the visual formatting, including the cell shade, color and border.</td>
</tr>
<tr>
<td><strong>Font format</strong></td>
<td>Cells that have had a change to the font formatting, including the font, font size, color, underline, style (italic, bold) and effect (strikethrough, superscript, subscript).</td>
</tr>
</tbody>
</table>

**Note:** These checkboxes only change what information is highlighted in the comparison. If you select a cell, all changes to that cell will be displayed in the change details panel on the right, regardless of which change type filters are selected.
Changes to a cell

You can dive into any cell to see all its changes. Select a cell and the changes are displayed in the change details panel on the right.

Each change is listed in its own card in the panel. The change type is displayed at the top of the card and also whether it’s a direct or indirect change. You can clearly see what the cell contained in the original spreadsheet and what it contains in the modified spreadsheet.

Navigate between changed cells

The Change Navigation buttons in the Home ribbon enable you to move quickly through the changes in the comparison.
There are four buttons:

- **Previous**: The previous change is highlighted.
- **Next**: The next change is highlighted.
- **First change**: The first change is highlighted.
- **Last change**: The last change is highlighted.

Priorities for highlighting direct and indirect changes

If a cell contains direct changes and indirect changes, the direct change takes priority and the cell is highlighted yellow.

Priorities for highlighting inserted and deleted cells

In cases where an inserted or deleted row intersects an inserted or deleted column, changes are displayed as follows:

- If an inserted column intersects with an inserted row, the cell displays as inserted (blue):

```
<p>| | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>27</td>
<td>58</td>
<td>8</td>
</tr>
<tr>
<td>35</td>
<td>47</td>
<td>18</td>
</tr>
<tr>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>65</td>
<td>25</td>
<td>62</td>
</tr>
<tr>
<td>17</td>
<td>56</td>
<td>67</td>
</tr>
<tr>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>50</td>
<td>36</td>
<td>67</td>
</tr>
</tbody>
</table>
```

- If an inserted column intersects with a deleted row, the cell displays as deleted (red):

```
<p>| | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>27</td>
<td>58</td>
<td>8</td>
</tr>
<tr>
<td>35</td>
<td>47</td>
<td>18</td>
</tr>
<tr>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>65</td>
<td>25</td>
<td>62</td>
</tr>
<tr>
<td>17</td>
<td>56</td>
<td>67</td>
</tr>
<tr>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>50</td>
<td>36</td>
<td>67</td>
</tr>
</tbody>
</table>
```

- If a deleted column intersects with an inserted row, the cell displays as deleted (red):

```
<p>| | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>27</td>
<td>58</td>
<td>8</td>
</tr>
<tr>
<td>35</td>
<td>47</td>
<td>18</td>
</tr>
<tr>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>65</td>
<td>25</td>
<td>62</td>
</tr>
<tr>
<td>17</td>
<td>56</td>
<td>67</td>
</tr>
<tr>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>50</td>
<td>36</td>
<td>67</td>
</tr>
</tbody>
</table>
```
If a deleted column intersects with a deleted row, the cell displays as deleted (red):

![Cell deletion example](image)

### Working with Comparisons

#### Swapping the source files

You can re-run a comparison exchanging the original spreadsheet for the modified spreadsheet and vice versa. For example, if you selected Spreadsheet A as the original spreadsheet and Spreadsheet B as the modified spreadsheet, Workshare Compare for Excel shows the changes made to Spreadsheet A to produce Spreadsheet B. You can then swap the spreadsheets so that Spreadsheet B is now the original and Spreadsheet A is the modified spreadsheet. Workshare Compare for Excel automatically re-runs the comparison and shows the changes made to Spreadsheet B to produce Spreadsheet A.

**To swap the source spreadsheets:**

Click **Swap** in the Home ribbon. Workshare Compare for Excel automatically runs a new comparison, using the modified spreadsheet as the original spreadsheet and the original spreadsheet as the modified spreadsheet. The new comparison is displayed in the Workshare Compare for Excel window replacing the previous comparison.

#### Saving comparisons

You can quickly export your changes to a new Excel file that you can save and share. You can save the file in your DMS or CRM, locally or on your network.
To export the comparison:

1. Click Export in the Home ribbon. The Export to Microsoft Excel dialog opens.

![Export to Microsoft Excel](image)

**What do you want to export?**

- [ ] Entire workbook
- [ ] Selected sheets

**Include:**

- [x] Change type filters
- [x] Indirect highlights
- [x] Source formatting

[Export] [Cancel]

2. Select whether you want to export the **Entire workbook** or only some **Selected sheets**.

3. If you choose **Selected sheets**, click inside the **Select one or more sheets** field and choose the sheets to export.

![Select one or more sheets](image)

4. By default, all of the following will be included in the comparison:
   - **Change type filters**: All change type filters currently highlighted.
   - **Indirect highlights**: All indirect changes.
   - **Source formatting**: Source formatting from the original and modified files.

   If you would like to exclude any of these options, deselect them.

5. Click **Export**. The Save As dialog opens.

6. Navigate to a save location.
7. In the **File name** field, enter a name for the new file.

8. Click **Save**. The comparison is exported as a new Excel file.

**Note:** The file does not open automatically after it’s saved.

The first worksheet of the Excel file is the Change Report. It lists every change from the comparison (excluding any changes you chose not to include when you exported the comparison). To jump to a change, click its **View** option in the Link column.

The other worksheets correspond to the worksheets in the original and modified files. Select a sheet to view its comparison.
Chapter 5: Working Online

This chapter describes the file share & sync element of your installation, which brings the online secure file sharing, collaboration and storage features of Workshare to your desktop. It includes the following sections:

- **Overview**, page 113, introduces the online functionality available with Workshare.
- **Syncing local files**, page 113, describes how to use the Workshare desktop app to sync content between your desktop and Workshare online.
- **Getting content online**, page 127, describes how to share files to Workshare groups from open Office documents and using right-click options.
Overview

With file share & sync included in your installation, you can add your files to the secure Workshare online platform. Once there, you can access your files from anywhere and share them securely with people inside or outside your organization.

Workshare integrates with File Explorer so you can save and organize your files in local folders that function seamlessly on your hard drive, but automatically synchronize with Workshare online. Workshare also integrates with Office so you can share for review, for example, from right inside Word.

Workshare is available online through a browser at my.workshare.com. Content is divided into different areas to suit your needs:

- **Folders**  
  Use Folders to publish files and make them available to others. Within Folders, use My Files to store your own private files that you don’t want to share with anyone but you want easy access to from anywhere.

- **Groups**  
  Use groups as workspaces where you can collaborate on files with people inside and outside your company.

Workshare integrates its save and share functionality into your familiar working environment:

- Using the Workshare sync folder on your desktop, you can save and share any files to all areas of Workshare online
- From open Office documents, you can save files to My Files in Workshare and share files into Workshare groups
- From your desktop, you can right click any file and share it to a group in Workshare

In order to access and use Workshare online, you must have a Workshare account.

Syncing Local Files

The Workshare sync folder is your local access point to the online services of Workshare. Both the Workshare sync folder and the synchronization functionality are provided by the Workshare desktop app.
What is the desktop app?

With file share & sync included in your installation, the Workshare desktop application (the desktop app) is installed. This is an application that syncs content between Workshare online and your PC so you can access your files and continue collaborating from your desktop while offline. The key features of the desktop app are as follows:

- **Synchronization** - Synchronizes groups, folders and files between Workshare and your desktop. You can be selective about what is synchronized to reduce the storage footprint on your local machine. If you can’t work online, as soon as you’re back online, the new versions are uploaded right away.

- **Integration** - Integrates Windows with Workshare online linking Workshare directly to everyday applications – users can save files directly into the Workshare sync folder from where they are copied into Workshare online.

Launching the desktop app for the first time

The desktop app is launched once the Workshare installation is complete.

The installation of the desktop app places an icon in your Windows taskbar for basic management and it puts a folder in your Favorites/Quick access section in File Explorer, so you can quickly access and save your Workshare content. In order to access and use the desktop app, you must log in to it. You only need to perform this login once; afterwards the desktop app will launch automatically when Windows starts. You use your Workshare login credentials to log in to the desktop app.
To log in to the desktop app for the first time:

- When the desktop app launches after installation, enter the email address and password you used to sign up for Workshare and click **Sign In**.

**Note:** You can also display the login page by clicking the Workshare icon on your desktop or selecting **Workshare Desktop** from the Start menu.

The Workshare desktop app looks very similar to Workshare online accessed from a browser.

In fact, from the desktop app, you can do all the things you can do when logging into Workshare online through a browser.

Once you have logged in:

- Your files and folders from your online Workshare account start to synchronize to your local Workshare sync folder
- The desktop app icon appears in your system tray

**Workshare sync folder**

The Workshare sync folder is your local access point to your online Workshare content. You can always find the latest copy of your Workshare files and you can add files to Workshare via the sync folder. It appears in your Favorites/Quick access section and its default location is C:\Users\[user name]\Workshare. You can change the location of the Workshare sync folder in Preferences > Sync Settings, described in **Configuring the Workshare Desktop App**.

You can also click **Open Workshare Folder** from the desktop app main window.

In your Workshare sync folder, you will see all your synchronized Workshare files and folders, grouped as follows:

- **Folders**: Shows all your Workshare files and folders, including files you have uploaded, as well as files others have shared with you. There are also three default folders:
  - **My Files**: Includes personal files that you don’t want to share.
  - **Received**: Includes all the files sent to you by secure file transfer from Outlook.
  - **Sent Files**: Includes all the files you sent out to others by secure file transfer from Outlook.
- **Group Files**: Includes all your Workshare groups which are flexible workspaces ideal for projects that require dynamic conversations.

If you add, update or delete a file in your Workshare sync folder, it will be added, updated or deleted in Workshare online too. Similarly, if you add, update or delete a file in a synced folder in Workshare online through the web app on a browser, the changes will be seen in the Workshare sync folder.
The icon to the left of a file/folder indicates its sync status:

- Waiting to be synchronized or synchronization is in progress
- Synchronized

In this two-way file synchronization, updated files are copied in both directions, usually with the purpose of keeping the two locations identical to each other. You can control what is synced from your desktop just by adding or replacing files in your Workshare sync folder. Careful though because anything you remove from your Workshare sync folder will also be removed from your Workshare online content.

**Default sync**

By default, the following files are synchronized:

- Files you add to My Files
- Files you add to a shared folder or a group that you own
- Files others add to a shared folder or a group that you own

You can select which folders to sync using the selective sync option. Refer to *Selective synchronization*.

**System tray icon**

The desktop app system tray icon shows the status of the desktop app as follows:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Synced</td>
<td></td>
<td>The files in your local Workshare desktop folder are fully synced you’re your online Workshare content.</td>
</tr>
<tr>
<td>Sync in progress</td>
<td></td>
<td>The files in your local Workshare desktop folder are currently syncing with your online Workshare content.</td>
</tr>
<tr>
<td>Pause</td>
<td></td>
<td>Synchronization between your local Workshare desktop folder and your online Workshare content is currently paused.</td>
</tr>
<tr>
<td>Conflict</td>
<td></td>
<td>There is a conflict between files in your local Workshare desktop folder and files in your online Workshare content.</td>
</tr>
<tr>
<td>Upgrade</td>
<td></td>
<td>An upgrade is available for the Workshare desktop app.</td>
</tr>
<tr>
<td>Offline</td>
<td></td>
<td>The desktop app has been placed offline so no synchronization can occur.</td>
</tr>
</tbody>
</table>
Clicking the icon displays the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open Workshare App</td>
<td>Opens the Workshare desktop app window.</td>
</tr>
<tr>
<td>Open Workshare folder</td>
<td>Opens the Workshare sync folder.</td>
</tr>
<tr>
<td>Files up to date/conflicts</td>
<td>Indicates that all files are synchronized successfully or if there are sync conflicts between the desktop app and Workshare.</td>
</tr>
<tr>
<td>Pause</td>
<td>Pauses the current synchronization. The option becomes Resume Syncing when synchronization is paused.</td>
</tr>
<tr>
<td>Refresh</td>
<td>Refreshes the display and synchronizes with Workshare online.</td>
</tr>
<tr>
<td>Recycle Bin</td>
<td>Displays the Workshare recycle bin which includes all the Workshare files, folders and groups that have been deleted.</td>
</tr>
<tr>
<td>Selective Sync</td>
<td>Enables you to select which folders are synchronized between your desktop and Workshare online.</td>
</tr>
<tr>
<td>Preferences</td>
<td>Enables you to change application settings for the desktop app, such as the location of the sync folder or general account settings.</td>
</tr>
<tr>
<td>Help and support</td>
<td>Provides access to the Workshare knowledge base.</td>
</tr>
<tr>
<td>Quit Workshare</td>
<td>Stops the synchronization between your desktop and Workshare online.</td>
</tr>
</tbody>
</table>

**Adding files to Workshare via the sync folder**

You can add most file types to your local Workshare sync folder which will then be synchronized with your Workshare online account. You can add files to existing groups or folders or create new folders. You cannot create new groups from within the sync folder.

*Note: Groups are created in Workshare from the web app or the desktop app.*

You can simply copy/paste or save files into your local Workshare sync folder and they will be synchronized to Workshare online by default. However, if you have selected that specific folders do not synchronize then files added to those folders will not be synchronized. Refer to *Selective synchronization.*
To copy/paste to your local Workshare sync folder:

Drag the files or folders you want to add into your local Workshare sync folder.

To save files to the Workshare sync folder:

1. Open a file – this can be any file, for example, a Word file, a PowerPoint presentation or an image file.
2. Click Save As.
3. Browse to your Workshare sync folder in Favorites/Quick access. By default this folder is located at Users\[user name]\Workshare.
4. Browse to a location in any of the three areas in Workshare and select an existing folder or create a new folder.
5. Click Save. Your file is now saved in your local Workshare sync folder and it is immediately synchronized to Workshare online (unless the selected folder is not set to synchronize).

Files won’t sync from here…

- Files or folders added to the top level “Workshare” folder in your local sync folder will not be synchronized. Files and folders must be added into one of the two areas of Workshare – Folders or Group Files.
- New folders added to the Group Files area will not be synchronized – Groups can only be created via the web app.
In either of the above scenarios, the icon 📁 next to the file and a popup message alert you that the file/folder cannot synchronize to Workshare.

Clicking View opens the non-syncing folder locally so you address the problem.

**Restoring deleted files**

From the desktop app, you can access the Workshare online recycle bin where you can restore any of your accidentally deleted files, folders or groups. The recycle bin lists all your Workshare files and folders (those you own) that have been deleted – you may have deleted them using a web browser, from the desktop app or directly from the Workshare sync folder.

**Note:** When you have deleted files and folders from the desktop app or the Workshare sync folder, you will only see the deleted files and folders in the recycle bin after synchronization.

The desktop app provides a window into the Workshare online recycle bin so if you are offline, you will not be able to access the recycle bin.
To access the recycle bin:

Click **Recycle Bin** in the left panel.

In the recycle bin you can see:

- Files, folders and groups owned by you that have been deleted by anyone; and
- Files, folders and groups owned by anyone that have been deleted by you.

You can filter the list to see what was deleted by you and what was deleted by others.

- Click **Restore All** to restore all files and folders in the recycle bin back to their original location.
- Click **Empty Recycle Bin** to permanently delete all files and folders in the recycle bin.
To restore selected files:

1. Click **Recycle Bin** in the left panel.

2. Select a file or a folder (or several files and folders). The buttons change to **Restore Selected** and **Empty Selected**.

3. Click **Restore Selected** to restore the selected folders and files.

File synchronization

The desktop app synchronizes your online Workshare content to your local machine so you can access your files and continue collaborating when offline. By default, the following files are synchronized:

- Files you add to My Files
- Files you add to a shared folder or a group that you own
- Files others add to a shared folder or a group that you own

So if you add any of these files to Workshare via a web browser, they will be synced to your desktop and you will be able to access them from the Workshare desktop app (or sync folder). Synchronization works both ways so if you delete any of these files from the Workshare desktop app (or sync folder), they will be deleted from Workshare online and you will no longer be able to access them via a web browser.

Synchronization between Workshare online and your desktop occurs in the following situations:

- When logging into the desktop app
- When a new event occurs on Workshare online, such as a new file uploaded or a new version added
- When a new event occurs in the Workshare desktop app (or sync folder), such as a new folder created or a file added
- When the desktop app has been offline and then you go back online
- When clicking Refresh in the desktop app system tray menu
- When clicking Update and Sync in the Selective Sync page

You can pause synchronization at any time, for example, if you have a slow connection, and then restart it when convenient.

**To pause synchronization:**

Click the desktop app system tray icon and select Pause. Synchronization stops.

To restart synchronization, click the desktop app system tray icon and select Resume.

**Selective synchronization**

You can modify the default synchronization settings so that less files and folders are synchronized to your desktop in order to reduce the storage footprint on your local machine.

**To select folders to synchronize:**

1. Click Selective Sync in the desktop app main window (or from the desktop app system tray menu or the File menu). The selective sync page is displayed showing the root folders on Workshare – Folders and Group Files.

2. Click a folder to display its subfolders.

3. Select the folders that you want to synchronize between Workshare and your desktop by selecting the checkbox to the left of the folder/subfolder name. Selecting or deselecting a folder will automatically select/deselect the subfolders belonging to the folder. However, you can select a folder but then manually deselect some of its subfolders. Use the Select All checkbox to quickly select/deselect all folders.

**Note:** By default when a folder or group is shared with you it is not selected for synchronization. To change this, select the Automatically sync new folders shared with me checkbox.

4. Click Update and Sync. All folders with a selected checkbox will be synchronized. The progress of the synchronization is shown in the sync progress page.

Folders that are not synchronized will not appear in your local Workshare sync folder.
Sync progress

The sync progress page shows the folders and files currently being synchronized.

To display the sync progress page:

When synchronization is in progress, select Sync Progress from the View menu.

The status bar provides a summary of the sync situation and the sync progress report provides a detailed view.

The files being synchronized are shown in a queue format. If you want to move a file in the queue, for example, you want to upload a small Word document and it is being held up by a large PowerPoint presentation, right-click the file you want to delay and select Lower the sync priority.
Synchronization conflict

The sync conflicts page provides a dedicated area where you can deal with file conflicts. Possible conflict scenarios include:

- You have opened a synced file locally and you are editing it. Meanwhile, in the web app, a new version is added to the file. When you save the open file, a conflict is shown.
- Two users are working offline and make changes to a file they share. User 1 goes back online and the revised file is synced to Workshare online as a new version. User 2 goes back online and a conflict is shown.

In your local Workshare sync folder, the file icon shows there is a conflict:

In addition, the desktop app system tray icon shows there is a conflict and the menu includes a **Conflicts** option:

```plaintext
- Open Workshare App
- Open Workshare folder
- All files and folders are up to date
  - Conflicts (1)
  - Pause
  - Refresh
- Recycle Bin
- Selective Sync...
- Preferences...
- Help and support
- Quit Workshare
```
To resolve a conflict:

1. Click **Conflicts** in the desktop app main window (or from the desktop app system tray menu). The sync conflicts page is displayed listing the files with conflicts.

2. Expand a file in the sync conflicts page by clicking ✅. The options for resolving the conflict are displayed. For example, you may want to add your file as the latest version or overwrite your version with the online version. You can always opt to keep both files involved in the conflict. Different options are displayed according to the particular conflict.

![Sync Conflicts](image)

3. Select the option you want to apply and click **Resolve**.

**Note:** When there are no conflicts, the sync conflicts page is not available.
Collaborating in Workshare

Once you have shared folders with other users, those users will be able to access Workshare via the web app, view the files in the folder and add comments in real-time. If they have permission, they could also add new versions to a file. Any new versions will be synchronized to your desktop and you can also add versions to Workshare files from your desktop through your Workshare desktop app or your local Workshare sync folder. For example, simply open a file from your local Workshare sync folder, edit it and save it and it will be synced to Workshare online and appear as a new version.

You can also open any file and save over a file in your local Workshare sync folder. It will be synced to Workshare online and appear as a new version.
Getting Content Online

As well as using your local Workshare sync folder to get your content online, you can use the right-click options and toolbar options added by the file share & sync element of your Compare installation.

Right-click sharing

The way to share files and folders from your desktop is to share them to a Workshare group.

Right-clicking any file on your desktop provides the option to share it to a group. The file or folder will be added to the group’s files and all members of the group will be able to access it.

To share to a group:

1. In File Explorer, right-click any file or folder.
2. Select Workshare, then Share to group.

![Share to group window](image-url)
3. Enter the name of the group you want to share the file/folder with. When you click in the text box, a list of the most recent groups selected is displayed. As you start to enter a name, groups are suggested to you.

![Image showing group selection]

4. Select an existing group or enter a new group name and click **Create a new group**.

*Note: Click Change Group to remove the specified group so you can select another one.*

5. If you want to change the name of the file/folder you are sharing, click and edit the name.

6. Click **Share**. The file/folder is uploaded to the specified group in Workshare online. If the group is synced, the added file or folder will also appear in the selected group in your local Workshare sync folder.

**From open Office documents**

Using Workshare toolbar options, you can save your Office files to Workshare online so they will be accessible to you online at all times. You can save them directly to a folder in My Files if they are private files that you don’t want to share with anyone or you can save them directly to a group if you want to collaborate on them with people inside and outside your company.

You can save Word, Excel and PowerPoint files in their native format or convert them to PDF as you save.

*Note: You can also save redlines to Workshare online from within Workshare Compare. Refer to Saving redlines to Workshare online.*

Additionally, you can display the Workshare Connect panel inside Office which provides a window into the document you have shared to a Workshare group.
Saving to My Files

The My Files area of Workshare online is where you can securely store your own private files that you don’t want to share with anyone but you want easy access to from anywhere.

To save documents to My Files:

1. Open a file in Microsoft Word, Excel or PowerPoint.

2. In the Workshare tab, click **Save to My Files**. The **Save to My Files** dialog is displayed.

   ![Image](Image)

   Tip! You can also display this dialog using Workshare options in the File menu.

3. Browse through My Files and select the folder where you want to save the file.

   Note: To create a new folder, click **Create new folder**, enter a name for the folder and click **Create**.

4. In the **File name** field, modify the name of the file as required.
5. From the **Save as type** dropdown list, select the format for the saved file from the following:
   - **Word Document/Excel Workbook/PowerPoint Presentation**: Saves the file in its native format
   - **PDF**: Saves the file as a PDF file
   - **PDF/A**: Saves the file as a PDF/A file

6. Click **Save**. The file is saved to the specified folder in Workshare My Files and you can log into Workshare and access the file from anywhere. The following notification pops up on your desktop:

   ![File saved to Workshare](image)

   You can click **View** to open the file in Workshare in your browser or click **Copy link** to copy the URL to the file to your clipboard. You can then paste this link to another location, for example, an email or an instant message.

   If the Workshare My Files folder is synced, the added file or folder will also appear in your local Workshare sync folder.

   Once you have saved a file to My Files, you can continue working and making changes as required. Clicking **Save to My Files** again will save the file to Workshare with the same name and in the same location as a new version. If you want to save the file to My Files as a new file with a different name, click the arrow on the **Save to My Files** button and click **Save as**.
Sharing to a Workshare group

By sharing files to Workshare groups, you save your file to a group in Workshare and all members of that group can access your file and collaborate on it with you.

To share documents to a group:

1. Open a file in Microsoft Word, Excel or PowerPoint.
2. In the Workshare tab, click **Share**. The **Share** dialog is displayed.

3. Enter the name of the group you want to share the file with. As you start to enter the name, groups are suggested to you.

4. Select a group or enter a new group name and click **Create a new group**.

5. Edit the name of the document by clicking **Edit** icon, modifying the name and then clicking **Apply**.
6. Click **Share**. The document is saved to the group in Workshare and a confirmation dialog is displayed.

   ![File shared](https://example.com/file-sharing-dialog.png)

   If the Workshare group is synced, the added file or folder will also appear in your local Workshare sync folder.

7. Continue in one of the following ways:
   - Click **Create email** to open a new email in Outlook that includes a link to the document in Workshare. You can invite people to the group by sending the email to them.
   - Click **Go to group** to open the group in Workshare in your browser where you can see the document, set group permissions and select members.

   **Note**: Click ![Copy link](https://example.com/copy-link-icon.png) to copy the link to the document to your clipboard. You can then paste this link to another location, for example, an email or an instant message.

**Monitoring shared files**

The Workshare Connect panel inside Office provides a window into the files you have shared to Workshare groups.
When you have shared a document into a group in Workshare and you open the document locally, the Workshare Connect panel provides a view of what is happening with your collaboration. You can see the other reviewers (the members of the group) and whether they are online at the moment. You can also see how many comments have been made on the document and whether any new versions have been added to it. With a single click you can open the document in Workshare online via a browser and join in the collaboration by viewing comments and making your own comments.

If you open a shared document in Office and the Workshare Connect panel is not displayed, click **Toggle Panel** in the Workshare tab to display it. When the document is not shared to a Workshare group, the panel will look something like this:
Once your document is shared, the Workshare Connect panel will provide real-time information about the collaboration, like new comments and versions.

**New versions**

When another group member adds a new version of the document, you are notified in the Workshare Connect panel. Click **Download** and the new version is downloaded and opened. Now the Workshare Connect panel will ask if you’d like to see what’s different between this new version and the previous version. With a single click, both versions are compared in Workshare Compare.
Comments added
In the Comments tab, you can see the number of comments made on the version of the file you are looking at (in orange) as well as the total number of comments on all versions of the file. If you want to see the actual comment, click View online and open the file in Workshare via a browser so you can view comments and update versions and add comments if you want. When comments are made that you have not yet seen, click the Unread comments alert and the file is opened in Workshare via a browser.

Group members
In the People tab, you can see all members of the group that have access to your document. A green light indicates the member is currently viewing the file. The following three lists are available:

- **Everyone**: All members who have access to the file
- **Reviewers**: Any member who has looked at the file
- **Editor**: A member who has looked at the file in Word (and had Workshare installed and the Connect panel turned on)
Chapter 6: Advanced PDF Functionality

This chapter describes how to convert a PDF file to a Microsoft Word file. It includes the following section:

- **Converting PDF Files to Word Format**, page 137, describes how to convert a PDF document into Microsoft Word format.
Converting PDF Files to Word Format

**Note:** This functionality is not available when Workshare Compare is installed in Office 2013 environments (and above); they have this functionality built-in.

Workshare Compare provides accurate conversion of PDF files to Microsoft Word files (PDF to DOC/DOCX format) preserving document formatting and page layout. This functionality is available from within Microsoft Word and by right-clicking closed PDF files on your desktop.

Converting a PDF document into Word format is useful if you want to edit the document, as PDF documents cannot be edited as easily as Word documents.

**Notes:**
Workshare cannot convert secure PDFs, meaning PDF files with security settings configured.

Scanned PDF files will not be converted to editable text – the content remains as an image and cannot be edited.

**To convert a PDF:**

1. To convert a PDF document to DOC format:
   - Right-click the closed PDF file and select **Open in Word with Workshare**.
   - From Microsoft Word, click **Open**. Browse to the PDF file and click **Open**.
The *Open PDF in Word* dialog is displayed.

2. Select a conversion method according to how much of the formatting and layout you want to preserve and click **OK**. The PDF document is converted to Word format and is opened in Microsoft Word.

You must save the document.

**Notes:**

The name in the title bar will still include the PDF extension. However, the document is in DOC/DOCX format.

When converting a PDF file to Word format, the display may vary according to the type of PDF. The type of PDF means the software used to create the PDF file. For example, Adobe, Amyuni, CutePDF, novaPDF, and so on.
Chapter 7: Configuring Workshare

This chapter describes the Workshare Configuration Manager. It includes the following sections:

- **Introducing the Workshare Configuration Manager**, page 140, introduces the Workshare configuration utility.
- **Accessing the Workshare Configuration Manager**, page 140, describes how to access the Workshare Configuration Manager.
- **Setting Parameters**, page 142, describes how to set values for parameters in the Workshare Configuration Manager.
Introducing the Workshare Configuration Manager

The Workshare Configuration Manager is a configuration utility that enables you to configure Workshare and the way it behaves as well as modify the configuration of the default profile (via the parameters in the Protection category).

Note: A profile is a collection of policies. A policy is a set of parameters applied by Workshare Protect when determining content risk.

Administrator Mode and User Mode

The Workshare Configuration Manager has two modes as follows:

- **Administrator Mode**: This mode is for administrators to make changes to the default settings on the local machine. Settings made are saved in HKEY_LOCAL_MACHINE in the Registry. As a user you will only have access to Administrator mode if you have Administrator rights.

- **User Mode**: This mode is for users to make changes to the Workshare configuration to suit their own personal preferences on the local machine. Other users could log in and they would not have the same configuration settings. Settings made are personal to the user and saved in HKEY_CURRENT_USER in the Registry.

Note: Your system administrator may have restricted the rights of users to modify configuration parameters by locking individual parameters so that users cannot override the setting. If you have restricted access rights and have special requirements for configuration, please speak to your system administrator.

Accessing the Workshare Configuration Manager

The Workshare Configuration Manager can be accessed from within Microsoft Office or from the Start menu.
To access the Workshare Configuration Manager from Microsoft Word:

In an open document, click **Options** in the **Workshare** tab or from the Start menu, select **Workshare Configuration (User Mode)**. The Workshare Configuration Manager opens in User Mode.

*Note: In User Mode, the state of the options reflects the settings in **HKEY_CURRENT_USER** in the Registry.*

The configuration parameters for Workshare are grouped into categories and sub-categories. Click a sub-category to display its parameters. The different sub-categories and their parameters are described in a separate guide - *Workshare Configuration Options*.

**Searching parameters**

If you know the name of a parameter (or part of its name) but not its location, you can search the Workshare Configuration Manager using the search box on the top right.
Click the parameter in the results list and the relevant category and sub-category are displayed in the Workshare Configuration Manager.

**Setting Parameters**

Most parameters in the Workshare Configuration Manager are set by selecting or deselecting a checkbox. There are also some that require you to enter a value in a text box.

**To specify parameters:**

1. In the Workshare Configuration Manager, select a category and then a sub-category.

2. Set a value for a parameter by selecting or deselecting the checkbox, selecting an option from a dropdown list or entering a value in a text box.

   ![Parameter Table]

   The icon to the right of a parameter indicates that the parameter value has been changed.

   **Note:** When parameters have been locked by your administrator, the parameter will be disabled and a lock symbol will appear to the left of the parameter. You cannot change locked parameters.

3. Continue to select categories and sub-categories and specify parameters as required.
4. Click **Apply** to save your settings. A confirmation message is displayed once the settings have been saved.

![Confirmation message]

4. Click **Apply** to save your settings. A confirmation message is displayed once the settings have been saved.

5. Click **OK** and restart all Microsoft Office applications.

**Note:** The different sub-categories and their parameters are described in the Workshare Configuration Options guide.
Appendix A. Configuring Rendering Sets

This appendix describes how to configure rendering sets for Workshare Compare and apply them to a comparison. It includes the following sections:

- **Introducing Rendering Sets**, page 145, introduces Workshare rendering sets and describes how they determine the look of a redline.
- **Accessing the Rendering Sets Manager**, page 146, describes how to access the Workshare Rendering Sets Manager.
- **Customizing Rendering Sets**, page 149, describes how to create your own rendering sets as well as modify and delete existing rendering sets.
- **Rendering Set Parameters**, page 150, provides a detailed description of all the parameters included in rendering sets.
Introducing Rendering Sets

Workshare Compare uses colors and different formats in the redline to enable you to see the changes that have been made to the documents.

For example, the following indications can be used:

- Deletions in **red with a strikethrough**
- Insertions in **bright blue with a double underline**
- Moved or cut text in **green with a strikethrough**
- Pasted (copied) text in **green with a double underline**
- Moved deletions in **salmon pink with a strikethrough**

The colors and formats adopted depend on the rendering set applied to the comparison.
Workshare Compare includes several different rendering sets that you can apply as required or you can modify these rendering sets or create your own rendering set.

**Note:** It is general practice that your system administrator will have been involved in creating a set of standard rendering sets for your company to use and may have restricted the rights of users to create, delete or modify their own rendering sets. If you have restricted access rights and have special requirements for rendering sets, please speak to your system administrator.

Where are rendering sets stored?

By default, rendering sets are stored in the following locations:

- The default rendering sets included with Compare are machine-wide rendering sets and are stored in a shared documents folder at the following location: C: Users > Public > Public Documents > Workshare > Rendering.
- Any further rendering sets created by users are personal rendering sets and are stored in C: Users > (user name) > My Documents > Workshare > Rendering. This can be changed by an administrator in the Default location rendering set parameter in the Workshare Configuration Manager (Comparison > Administration category).

You can store rendering sets at other locations but you must specify the location (or locations) in the Additional locations for rendering sets parameter in the Workshare Configuration Manager (Comparison > Administration category). Workshare Compare looks in the two default locations (specified above) to create a list of the possible rendering sets available and will also look in any additional locations specified in this parameter.
Applying rendering sets

You apply a rendering set to a comparison before the comparison is run and you can also apply a rendering set at any time after a comparison has been performed.

To apply a rendering set after the comparison has been run:
- Refer to Applying a different rendering set
- Refer to Changing the comparison options

Accessing the Rendering Sets Manager

The Rendering Sets Manager is accessible from the Workshare Configuration Manager, from Workshare Compare and from the Workshare tab in Microsoft Office.

From the Workshare Configuration Manager

Access the Workshare Configuration Manager and select the Rendering Set Manager tab.

If you have permissions, you can modify and delete existing rendering sets and create new rendering sets. Refer to Customizing Rendering Sets.
Before running a comparison

Before running a comparison, click 📜 in the Compare Documents dialog.

If you have permissions, you can modify and delete existing rendering sets and create new rendering sets. Refer to Customizing Rendering Sets.

Additionally, you can edit the rendering set parameters as required and click OK. The Save Rendering Set dialog is displayed where you can either:

- Enter the name of an existing rendering set to overwrite a rendering set or enter a new name to create a new rendering set. Do not use the following characters when naming rendering sets: <, >, :, \, ”, /, \ or |. Click Yes. The updated rendering set is saved and it is selected in the Compare Documents dialog.

- Click No. The revised options are saved as a temporary rendering set called “Custom rendering set” and this rendering set is selected in the Compare Documents dialog.
After running a comparison

In the Workshare Compare main window, click **Edit** in the Home ribbon (**Comparison Themes** group).

If you have permissions, you can modify and delete existing rendering sets and create new rendering sets. Refer to Customizing Rendering Sets.

Additionally, you can re-run a comparison changing specific comparison options. Refer to **Changing the comparison options**.
Customizing Rendering Sets

If you have the relevant access rights, you can modify and delete existing rendering sets as well as create new rendering sets.

**Note:** Depending on how Workshare Compare has been distributed through the company, you may or may not have access rights to configure rendering sets. If you have any questions about your access rights, please speak to your system administrator.

Modifying existing rendering sets

If you have permission, you can modify the settings of an existing rendering set.

**To modify an existing rendering set:**

1. In the Rendering Sets Manager, select the rendering set you want to modify from the **Rendering Set** dropdown list.

2. Configure or modify the parameters for the rendering set as follows:
   - Click a category in the left pane to display parameters for that category in the right pane.
   - Configure the parameters as required.
   
   Categories and their parameters are described in **Rendering Set Parameters**.

3. Click **Save**. The modified settings are saved to the selected rendering set.

Creating new rendering sets

If you have permission, you can create a new rendering set. You create a new rendering set based on an existing rendering set and then modify it as required.

**To create a new rendering set:**

1. In the Rendering Sets Manager, select the rendering set on which you want to base your new rendering set from the **Rendering Set** dropdown list.
2. Click **Save As**. The **Save Rendering Set** dialog is displayed:

![Save Rendering Set dialog]

3. Enter a name for the rendering set. Enter the name of an existing rendering set to overwrite a rendering set or enter a new name to create a new rendering set. Do not use the following characters when naming rendering sets: `<`, `>`, `;`, ``, `/`, `\` or `|`.

4. Click **OK**. The new rendering set is selected in the **Rendering Set** dropdown list.

5. Configure or modify the parameters for the rendering set as follows:
   - Click a category in the left pane to display parameters for that category in the right pane.
   - Configure the parameters as required.

Categories and their parameters are described in Rendering Set Parameters.

6. Click **Save**. The settings are saved to your new rendering set.

### Deleting rendering sets

If you have permission, you can delete rendering sets from the Rendering Sets Manager.

**To delete a rendering set:**

1. In the Rendering Sets Manager, select the rendering set that you want to delete from the **Rendering Set** dropdown list.

2. Click **Delete**. The selected rendering set is deleted.

### Rendering Set Parameters

The parameters for rendering sets are grouped into the following categories:

- Comparison Options
- Redline Options
- Redline Rendering
The categories appear in the left pane of the Rendering Sets Manager. Selecting a category displays the parameters for that category in the central pane. The right hand pane show a preview of how the redline will look with the parameters selected.

**Comparison Options**

The **Comparison Options** category includes parameters that enable you to customize how the compare is performed.

- Allow Auto Retry
- Detect List Numbering Changes
- Detect Footnote/Endnote Numbering Changes
- Compare Headers/Footers
- Compare Footnotes
- Compare at Character Level
- Compare Numbers at Character Level
- Ignore Embedded Objects/Images
- Ignore Case Changes
- Ignore Text Boxes
- Ignore Field Codes
- Compare field contents as text
- Ignore Tables
- Display comments in redline
- Detect Changes to Images
- Ignore auto list against manual number list changes
The Comparison Options parameters are described in the following table:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Allow Auto Retry</strong></td>
<td>When selected, if a comparison fails for any reason then Workshare Compare automatically attempts to perform a comparison using reduced settings. Workshare Compare methodically and automatically disables the Comparison Options selected until it is able to perform a comparison.</td>
</tr>
<tr>
<td><strong>Detect List Numbering Changes</strong></td>
<td>If selected, changes to automatically generated list numbers for numbered paragraphs are detected.</td>
</tr>
<tr>
<td><strong>Detect Footnote/Endnote Numbering Changes</strong></td>
<td>If selected, changes to the numbering of footnotes and endnotes are detected. You may want to deselect this parameter yet keep the <strong>Compare Footnotes</strong> parameter selected. This way, changes to the content of footnotes and endnotes will be detected but not changes to the numbering.</td>
</tr>
<tr>
<td><strong>Compare Headers/Footers</strong></td>
<td>If selected, the headers and footers in the original and modified documents are compared.</td>
</tr>
<tr>
<td><strong>Compare Footnotes</strong></td>
<td>If selected, the footnotes in the original and modified documents are compared.</td>
</tr>
<tr>
<td><strong>Compare at Character Level</strong></td>
<td>If selected, words that are only slightly different from each other are compared. For example, if <em>banana</em> has been changed to <em>bananas</em> - Workshare Compare shows just an insertion of an <em>s</em> in the redline, rather than showing a deletion of <em>banana</em> and an insertion of <em>bananas</em>. This is intended to catch simple typing mistakes.</td>
</tr>
<tr>
<td><strong>Ignore Embedded Objects/Images</strong></td>
<td>If selected, embedded objects and images are ignored while doing the comparison and will not be displayed in the redline. If not selected, the embedded objects and images will appear in the redline (although changes to them are not detected unless the <strong>Detect changes to Images</strong> parameter is selected.) This option is useful when documents have very large images embedded in them which would produce vast amounts of data if written to the redline RTF file and would slow down the comparison process and the loading of the redline.</td>
</tr>
<tr>
<td><strong>Ignore Case Changes</strong></td>
<td>If selected, any case changes, for example, upper case to lower case, made in the modified document are ignored.</td>
</tr>
<tr>
<td>Parameter</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Ignore Text Boxes</td>
<td>If selected, any text boxes in the modified document are ignored.</td>
</tr>
<tr>
<td>Ignore Field Codes</td>
<td>If selected, fields are treated as the same even if their field codes differ. So if you have a Date field in the original document and an Author field in the same place in the modified document, the redline will not show a change. If not selected, field codes are compared and where they have changed, the entire original field is shown as deleted and the entire modified field is shown as inserted.</td>
</tr>
<tr>
<td>Compare field contents as text</td>
<td>If selected, converts certain field codes to text and then compares. If not selected, compares field code only. Fields converted to text will not be subject to the <strong>Ignore Field Codes</strong> parameter if that is also selected. Note: The following field codes are converted to text: TOC, REF, TOA, TA, DATE, TIME, COMMENTS, KEYWORDS, AUTHOR, FILENAME, SAVEDATE, CREATEDATE, PAGEREF, INDEX, DOCPROPERTY, TITLE, MERGEFIELD, NOTEREF, SHAPE, QUOTE. Other field codes will be dealt with according to the <strong>Ignore Field Codes</strong> parameter setting. For example, where there is a date field that in the original document shows 1 Jan 2012 and in the modified updates to 31 Jan 2012. When this parameter is selected, the redline will show 131 Jan 2012. Where this parameter is not selected, no change will be shown.</td>
</tr>
<tr>
<td>Ignore Tables</td>
<td>If selected, any tables in the modified document are ignored.</td>
</tr>
<tr>
<td>Display comments in redline</td>
<td>If selected, comments in the original and modified documents are compared.</td>
</tr>
<tr>
<td>Detect Changes to Images</td>
<td>If selected, images in the original and modified documents are compared.</td>
</tr>
<tr>
<td></td>
<td>In order for images to be compared, you must ensure that the <strong>Ignore Embedded Objects/Images</strong> parameter is NOT selected.</td>
</tr>
</tbody>
</table>
### Parameter Description

**Ignore auto list against manual number list changes**

If selected, when an automatically formatted list is being compared against a manual list, any changes in the manual list are ignored. Generally this parameter should NOT be selected. It should only be selected in circumstances when one of the documents being compared contains automatic list numbering and the other document contains manual list numbering.

---

**Redline Options**

![Redline Options](image)

- **General Options**
  - Include redline statistics
  - Include Redline Comparison Summary
  - Include Redline Option Summary
  - Display Workshare Compare Footers
  - Black And White Headers
  - Black And White Footers
  - Show Moved Deletions
  - Show Changes to Spaces
  - Show Paragraph Changes
  - Include file names in Redline statistics

- **Change Indicator Options**
  - Show Hidden Text
  - Show Line Numbering
  - Show Change Numbering ToolTips
  - Show change bars
  - Show change numbers

- **Readability**
  - Paragraph Matched Text Threshold
The Redline Options category includes parameters that enable you to customize how the redline is displayed and what information is included with the redline.

The Redline Options parameters are described in the following table:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>General Options</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Include redline statistics</strong></td>
<td>If selected, statistics about the changes between the original and modified documents are displayed in the redline. You can select to display these statistics at the start of the document or at the end of the document.</td>
</tr>
<tr>
<td><strong>Include Redline Comparison Summary</strong></td>
<td>If selected, a summary of all the changes is displayed at the end of the redline. The changes are hyperlinked to take you directly to the change in the redline.</td>
</tr>
<tr>
<td><strong>Include Redline Option Summary</strong></td>
<td>If selected, a summary of the options selected in the current rendering set is displayed at the end of the redline in the statistics report.</td>
</tr>
<tr>
<td><strong>Display Workshare Compare Footers</strong></td>
<td>If selected, details about the two documents being compared are displayed in the footer of the redline.</td>
</tr>
<tr>
<td><strong>Black And White Headers</strong></td>
<td>If selected, changes detected in the header are rendered in black and white. The color scheme set up in the rendering set is maintained for changes to all other parts of the document.</td>
</tr>
<tr>
<td><strong>Black And White Footers</strong></td>
<td>If selected, changes detected in the footer are rendered in black and white. The color scheme set up in the rendering set is maintained for changes to all other parts of the document.</td>
</tr>
<tr>
<td><strong>Show Moved Deletions</strong></td>
<td>If selected, text that was deleted from a section of the document and then subsequently moved to a new location is indicated.</td>
</tr>
<tr>
<td><strong>Show Changes to Spaces</strong></td>
<td>If selected, any extra spaces that have been added to or deleted from the modified document are indicated.</td>
</tr>
<tr>
<td><strong>Show Paragraph Changes</strong></td>
<td>If selected, paragraph markers (¶) of any extra paragraphs that have been added to or deleted from the modified document are displayed.</td>
</tr>
<tr>
<td><strong>Include file names in Redline statistics</strong></td>
<td>If selected, the names of the compared documents are included in the redline statistics.</td>
</tr>
<tr>
<td><strong>Change Indicator Options</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Show Hidden Text</strong></td>
<td>If selected, hidden text is displayed in the redline.</td>
</tr>
<tr>
<td><strong>Show Line Numbering</strong></td>
<td>If selected, the line number is displayed to the left of each line in the margin of the redline.</td>
</tr>
<tr>
<td>Parameter</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Show Change Numbering ToolTips</td>
<td>If selected, tool tips are displayed when you position the cursor over change numbers.</td>
</tr>
<tr>
<td>Show change bars</td>
<td>If selected, vertical lines to indicate a change are displayed next to each change in the margin of the redline. You can select to display the lines either in the Left or Right margin.</td>
</tr>
<tr>
<td>Show change numbers</td>
<td>If selected, the change number is displayed next to each change in the margin of the redline. You can select to display the number either in the Left or Right margin.</td>
</tr>
<tr>
<td>Readability</td>
<td>See the Readability section below.</td>
</tr>
</tbody>
</table>

**Note:** The change indicator settings do not show if you open the redline in Microsoft Word.

**Readability**

The **Readability** option enables you to set at what point insertions and deletions should no longer be marked individually but marked as an entire paragraph deleted followed by an entire paragraph inserted. The deleted paragraph is as the paragraph appears in the original document and the inserted paragraph is as the paragraph appears in the modified document.

For example, the following paragraph showing numerous deletions and insertions is quite difficult to read:

**DeltaView Redline with Table of Contents:** (Vendor)When performing a Redline where the document contains an **contents issue:** An error occurs in the number of bullet points when DeltaView does a Redline on a document where the table of contents is automatically generated. The DeltaView output does not number the sections properly. This happens in DeltaView or if the file format is *.wdf. **Workaround:** Save the Redline as a new document or email the Redline as a Word document, it formats correctly. We are working with the vendor for a resolution.

It would be much easier to read this paragraph if it was presented as the entire paragraph deleted followed by a new paragraph inserted, as follows:

**DeltaView Redline with Table of Contents:** (Vendor)When performing a Redline where the document contains an automatically generated Table of Contents, the DeltaView output does not number the sections properly. This happens in DeltaView or if the file format is *.wdf. **Workaround:** Save the Redline as a new document or email the Redline as a Word document, it formats correctly. We are working with the vendor for a resolution.

**DeltaView Table of contents issue:** An error occurs in the number of bullet points when DeltaView does a Redline on a document where the table of contents is automatically generated in Word. **Workaround:** Save the table of contents in as a DOC file and open it in Word before printing.

Obviously, if there were only a few deletions and insertions in a paragraph, then the first example is easy to read.
With the Readability parameter, you can specify at what point Workshare Compare no longer marks deletions and insertions individually but marks the entire paragraph as a deletion followed by the new paragraph as an insertion. You specify this by setting a readability percentage by dragging the **Paragraph Matched Text Threshold** slider to your required setting. The percentage selected is shown in a tool tip below the slider.

The meaning of the setting is as follows:

- With readability set at 10%, Workshare Compare will mark insertions and deletions individually unless 90% of the paragraph has changed. In other words, in most circumstances paragraphs will be displayed in the same way as the first example shown previously. Only when more than 90% of the paragraph has changed will Workshare Compare display the paragraph as the second example.

- With readability set at 50%, Workshare Compare will mark insertions and deletions individually unless 50% of the paragraph has changed. In other words, paragraphs will be displayed in the same way as the first example shown previously unless more than 50% of the paragraph has changed.

- With readability set at 90%, Workshare Compare will mark insertions and deletions individually unless 10% of the paragraph has changed. In other words, in most circumstances paragraphs will be displayed in the same way as the second example shown previously. Only when less than 10% of the paragraph has changed will Workshare Compare display the paragraph as the first example.

The default setting for readability is 10%.

Workshare Compare looks at each paragraph separately and assesses its readability according to the number of changes in the paragraph.

**Note:** When working with tables, Workshare Compare does not treat the entire table as a paragraph. Each paragraph within each cell is treated separately.

Readability only applies to paragraphs that contain both inserted and deleted text because such paragraphs may be unclear whereas paragraphs with only insertions or deletions do not have such readability problems.
Redline Rendering

The Redline Rendering category includes parameters that enable you to customize how specific types of changes are displayed in the redline.

The Redline Options parameters are presented in the following sections:

Inserted Text

The Inserted Text section includes parameters that enable you to customize how you would like inserted text to appear in the redline.
The Inserted Text parameters are described in the following table:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inserted Text Color</td>
<td>The color of inserted text.</td>
</tr>
<tr>
<td>Inserted Text Background</td>
<td>The color of the background of inserted text.</td>
</tr>
<tr>
<td>Inserted Text Format</td>
<td>The format of inserted text. Select from Underline, Double Underline, Italic or Strikethrough.</td>
</tr>
<tr>
<td>Surrounding Characters</td>
<td>A keyboard character to go before and after inserted text.</td>
</tr>
</tbody>
</table>

Deleted Text

The Deleted Text section includes parameters that enable you to customize how you would like deleted text to appear in the redline.

The Deleted Text Format parameters are described in the following table:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deleted Text Color</td>
<td>The color of deleted text.</td>
</tr>
<tr>
<td>Deleted Text Background</td>
<td>The color of the background of deleted text.</td>
</tr>
<tr>
<td>Deleted Text Format</td>
<td>The format of deleted text. Select from Underline, Double Underline, Italic or Strikethrough.</td>
</tr>
<tr>
<td>Surrounding Characters</td>
<td>A keyboard character to go before and after deleted text.</td>
</tr>
</tbody>
</table>
### Configuring Rendering Sets

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deleted Text Replacement Character</td>
<td>The character used to replace deleted text. If the Replace Deleted Text with a Single Character checkbox is selected, the deleted text is replaced with a single instance of the character specified. If the Replace Deleted Text with a Single Character checkbox is not selected, each character in the deleted text is replaced with the character specified. For example, if the word <code>compare</code> is deleted and the character specified is <code>X</code>, the word appears as <code>XXXXXXX</code>.</td>
</tr>
<tr>
<td><strong>Replace Deleted Text with a Single Character</strong></td>
<td>If selected, deleted text is replaced with a single character. If you select this checkbox, enter the required character in the Deleted Text Replacement Character field. For example, if the word <code>compare</code> is deleted and the character specified is <code>X</code>, the word appears as <code>X</code>.</td>
</tr>
<tr>
<td>Include summary of deletions</td>
<td>If selected, a summary of deletions is included with the redline.</td>
</tr>
</tbody>
</table>

**Moved Text**

The **Moved Text** section includes parameters that enable you to customize how you would like moved text to appear in the redline.

![Moved Text](image)
## The Moved Text parameters are described in the following table:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Show Movements</strong></td>
<td>If selected, moved text is shown in the redline. If you leave this checkbox unchecked, then any text that has been moved is displayed the same as inserted and deleted text.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Text is only shown as moved if it's over 22 characters. Anything less will be shown as insertions and deletions. This is to prevent showing moved text incorrectly. For example, if someone had deleted the word &quot;and&quot; from one paragraph and added &quot;and&quot; in another, they probably have not moved the text, rather they are just changing the individual paragraphs, so would want them displayed as insertions and deletions.</td>
</tr>
<tr>
<td><strong>Moved Text Color</strong></td>
<td>The color of moved text.</td>
</tr>
<tr>
<td><strong>Moved Text Background</strong></td>
<td>The color of the background of moved text.</td>
</tr>
<tr>
<td><strong>Moved Source Text Format</strong></td>
<td>The format of the source moved text. Select the format of the text in its original position from Underline, Double Underline, Italic or Strikethrough.</td>
</tr>
<tr>
<td><strong>Moved Destination Text Format</strong></td>
<td>The format of the destination moved text. Select the format of the text in its new position from Underline, Double Underline, Italic or Strikethrough.</td>
</tr>
<tr>
<td><strong>Move Source Surrounding Characters</strong></td>
<td>A keyboard character to go before and after source moved text. Specify the characters to surround the text in its original position.</td>
</tr>
<tr>
<td><strong>Move Destination Surrounding Characters</strong></td>
<td>A keyboard character to go before and after destination moved text. Specify the characters to surround the text in its new position.</td>
</tr>
</tbody>
</table>
Change Numbering

The **Change Numbering** section includes parameters that enable you to select whether change numbers are shown in the redline and, if so, how they appear.

The Change Numbering parameters are described in the following table:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Change Numbering</td>
<td>If selected, the number of the change is displayed next to each change in the body of the redline (as superscript).</td>
</tr>
<tr>
<td>Show Change Numbering before Change</td>
<td>If selected, the change number is displayed before the change. If not selected, the change number is displayed after the change. It is recommended to position the change number before the change as footnotes often appear after text. This reduces confusion.</td>
</tr>
<tr>
<td>Change Number Text Color</td>
<td>The color of change numbers.</td>
</tr>
<tr>
<td>Change Number Text Format</td>
<td>The format of change numbers. Select from a range of formats, including <strong>Superscript</strong> or <strong>Bold</strong>.</td>
</tr>
</tbody>
</table>

Font Changes

The **Font Changes** section includes parameters that enable you to customize how you would like any font changes to appear in the redline.

The Font Changes parameters are described in the following table:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Font Changes</td>
<td>If selected, font changes are shown in the redline.</td>
</tr>
</tbody>
</table>
Configuring Rendering Sets

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Font Change Text Color</td>
<td>The color of font changes.</td>
</tr>
<tr>
<td>Font Change Text Background</td>
<td>The color of the background of font changes.</td>
</tr>
<tr>
<td>Surrounding Characters</td>
<td>A keyboard character to go before and after font changes.</td>
</tr>
</tbody>
</table>

**Note:** Insertions and deletions override any font changes. For example, if the modified document has new inserted text in a different font, it appears as inserted text and not as font change text.

Style Changed Text

The **Style Changed Text** section includes parameters that enable you to customize how you would like any style changes to appear in the redline.

The Style Changed Text parameters are described in the following table:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Paragraph Style Changes</td>
<td>If selected, paragraph style changes are shown in the redline. For example, normal to heading two.</td>
</tr>
<tr>
<td>Style Changed Label Color</td>
<td>The color of text in paragraphs where the paragraph style has changed.</td>
</tr>
<tr>
<td>Show Character Style Changes</td>
<td>If selected, character style changes are shown in the redline.</td>
</tr>
<tr>
<td>Style Changed Color</td>
<td>The color of character style changes.</td>
</tr>
</tbody>
</table>
Configuring Rendering Sets

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Style Changed Background</td>
<td>The color of the background of character style changes.</td>
</tr>
<tr>
<td>Style Changed Format</td>
<td>The format of character style changes. Select from Underline, Double Underline, Italic or Strikethrough.</td>
</tr>
<tr>
<td>Surrounding Characters</td>
<td>A keyboard character to go before and after style changed text.</td>
</tr>
</tbody>
</table>

**Note:** Changes to heading styles are also shown in the statistics report at the end of the redline.

Table Changes

The Table Changes section includes parameters that enable you to customize how you would like any format changes in tables to appear in the redline.

The Table Changes parameters are described in the following table:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table Change Options</td>
<td>The way changes in tables are indicated. You can select from the following: Changes with surrounding characters, Changes without surrounding characters, Whole original and modified tables, Whole modified table only or Whole modified table only (unmarked). Selecting Whole modified table only (unmarked), the modified table is shown in the redline as a new table with no changes marked. Selecting Whole modified table only, the modified table is also shown in the redline as a new table but it is shown as an insertion.</td>
</tr>
<tr>
<td>Table Cell Inserted Color</td>
<td>The color of inserted cells.</td>
</tr>
<tr>
<td>Parameter</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>------------------------------------</td>
</tr>
<tr>
<td>Table Cell Deleted Color</td>
<td>The color of deleted cells.</td>
</tr>
<tr>
<td>Table Cell Moved Color</td>
<td>The color of moved cells.</td>
</tr>
<tr>
<td>Table Cell Merged Color</td>
<td>The color of merged cells.</td>
</tr>
<tr>
<td>Table Cell Padding Color</td>
<td>The color of padded cells.</td>
</tr>
</tbody>
</table>

**What are padded cells?**

Padded cells occur when an insert and delete have occurred within a table, a cell becomes both an insert and a delete; therefore it creates a padded cell.

**Original Table**
```
<table>
<thead>
<tr>
<th>Cell 1</th>
<th>Cell 2</th>
<th>Cell 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cell 4</td>
<td>Cell 5</td>
<td>Cell 6</td>
</tr>
</tbody>
</table>
```

**Modified Table**
```
<table>
<thead>
<tr>
<th>Cell 1</th>
<th></th>
<th>Cell 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cell A</td>
<td></td>
<td>Cell B</td>
</tr>
<tr>
<td>Cell 4</td>
<td></td>
<td>Cell 6</td>
</tr>
</tbody>
</table>
```

**Rendered Table**
```
<table>
<thead>
<tr>
<th>Cell 1</th>
<th>Cell-2</th>
<th>Cell 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cell A</td>
<td>PADDED CELL</td>
<td>Cell B</td>
</tr>
<tr>
<td>Cell 4</td>
<td>Cell-5</td>
<td>Cell 6</td>
</tr>
</tbody>
</table>
```
Appendix B. Configuring Comparison Themes

This appendix describes how to configure comparison themes for Workshare Compare for PowerPoint and apply them to a comparison. It includes the following sections:

- **Introducing Comparison Themes**, page 167, introduces Workshare Compare comparison themes and describes how they determine the look of a comparison.
- **Applying Comparison Themes**, page 167, describes how to apply a comparison theme to a comparison.
- **Customizing Comparison Themes**, page 168, describes how to create your own comparison themes as well as modify existing comparison themes.
- **Comparison Theme Parameters**, page 170, provides a detailed description of all the comparison theme parameters.
Introducing Comparison Themes

Workshare Compare for PowerPoint uses colors and different formats in the comparison to enable you to see the changes that have been made to the presentation.

The colors and formats adopted depend on the comparison theme applied to the comparison. Workshare Compare for PowerPoint includes a default comparison theme that you can apply or you can modify this comparison theme or create your own comparison theme.

Applying Comparison Themes

You can apply a comparison theme to a comparison before the comparison is run and also at any time after a comparison has been performed.

To apply a comparison theme before the comparison is run:

In the Select Presentations for Comparison dialog, select a comparison theme from the Select Comparison Theme dropdown list.

To apply a comparison theme after the comparison has been run:

In the Comparison Themes group of the Home tab, select a comparison theme from the Select dropdown list. Workshare Compare for PowerPoint re-performs the comparison applying the new comparison theme styles to the resulting comparison.
Customizing Comparison Themes

You can modify existing comparison themes as well as create new comparison themes. Comparison themes are created and modified in the Comparison Themes Manager.

To open the Comparison Themes Manager:

Select Edit in the Comparison Themes group of the Home tab. The Comparison Themes Manager is displayed.

Note: You can also click to the right of the Select Comparison Theme field in the Select Presentations for Comparison dialog.

Comparison themes are made up of a set of parameters. The comparison theme parameters are grouped into categories. The categories appear in the left pane of the Comparison Themes Manager. Selecting a category displays the parameters for that category in the right pane of the Comparison Themes Manager. The different categories and their parameters are described in Comparison Theme Parameters.
Creating new comparison themes

You can create new comparison themes as required to determine the colors and formats used in the comparison to distinguish the changes that have been made to the presentation.

To create a new comparison theme:

1. In the Comparison Themes Manager, click **Create New**. The *Comparison Theme Name* dialog is displayed.

2. Enter a name for the comparison theme and click **OK**.

3. In the Comparison Themes Manager, specify the comparison theme parameters as follows:
   - Click a category in the left pane to display parameters for that category in the right pane.
   - Configure the parameters as required.

   Categories and their parameters are described in *Comparison Theme Parameters*.

4. Click **Apply**. The new comparison theme is saved.

   **Note:** When you click **OK** in the Comparison Themes Manager, Workshare Compare for PowerPoint re-performs the comparison applying the new comparison theme styles to the resulting comparison.

Modifying existing comparison themes

You can modify existing comparison themes by changing the parameter settings for the comparison theme or changing the name of the comparison theme. You can also delete unwanted comparison themes.

To modify an existing comparison theme:

1. In the Comparison Themes Manager, select the comparison theme you want to modify from the dropdown list.
2. Modify the comparison theme parameters as follows:
   - Click a category in the left pane to display parameters for that category in the right pane.
   - Configure the parameters as required.

Categories and their parameters are described in *Comparison Theme Parameters*.

3. Click **Apply**.

**Note:** When you click **OK** in the Comparison Themes Manager, Workshare Compare for PowerPoint re-performs the comparison applying the new comparison theme styles to the resulting comparison.

**To rename a comparison theme:**

1. In the Comparison Themes Manager, select the comparison theme from the dropdown list and click **Rename**. The *Comparison Theme Name* dialog is displayed.

2. Enter the new name for the comparison theme and click **OK**. The comparison theme is saved with the new name.

**To delete a comparison theme:**

In the Comparison Themes Manager, select the comparison theme that you want to delete from the dropdown list and click **Delete**. The comparison theme is deleted.

**Note:** You can delete one of the predefined comparison themes but all predefined comparison themes are regenerated when Workshare Compare for PowerPoint is launched.

**Comparison Theme Parameters**

The comparison theme parameters for Workshare Compare for PowerPoint are grouped into the following categories:

- Comparison
- Insertions
- Deletions
- Moves
- Property Changes
- Font Changes
- Sensitivity
Comparison

The **Comparison** category includes parameters that enable you to specify what changes Workshare Compare for PowerPoint will detect.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Detect Changes to</strong></td>
<td>Select the specific items that Workshare Compare for PowerPoint will detect changes to, from the following: <strong>Speaker Notes</strong>, <strong>Image Content</strong>, <strong>Embedded Object Content</strong>, <strong>Item Location and Size</strong>, <strong>Text Formatting</strong>, <strong>Text Box Formatting</strong>, <strong>Slide Background</strong>, <strong>Hyperlink Target</strong>, <strong>Autoshape Style and Orientation</strong>.</td>
</tr>
<tr>
<td><strong>Detect Moved Text</strong></td>
<td>If selected, moved text within slides is detected.</td>
</tr>
<tr>
<td><strong>Detect Moved Slides</strong></td>
<td>If selected, moved slides are detected.</td>
</tr>
</tbody>
</table>
Insertions

The **Insertions** category includes parameters that enable you to specify how inserted text as well as inserted images and objects will be displayed.

The Insertions parameters are described in the following table:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Insertion options</strong></td>
<td>Select how insertions are displayed. You can select any or a combination of the following formatting options for inserted text: <strong>Bold</strong>, <strong>Italic</strong>, <strong>Underline</strong> and <strong>Strikethrough</strong>. (You cannot select <strong>Underline</strong> and <strong>Strikethrough</strong>.) You also select the font color from the <strong>Color</strong> dropdown list. Inserted images and objects are indicated with a dashed border in the selected color. An example of how inserted text, inserted images and inserted charts will look with your selections is shown.</td>
</tr>
</tbody>
</table>
Deletions

The **Deletions** category includes parameters that enable you to specify how deleted text as well as deleted images and objects will be displayed.

The Deletions parameters are described in the following table:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deletion options</td>
<td>Select how deletions are displayed. You can select any or a combination of the following formatting options for deleted text: <strong>Bold</strong>, <strong>Italic</strong>, <strong>Underline</strong> and <strong>Strikethrough</strong>. (You cannot select <strong>Underline</strong> and <strong>Strikethrough</strong>.) You also select the font color from the <strong>Color</strong> dropdown list. Deleted images and objects are indicated with a dashed border in the selected color. An example of how deleted text, deleted images and deleted charts will look with your selections is shown.</td>
</tr>
</tbody>
</table>
Moves

The **Moves** category includes parameters that enable you to specify how moved text as well as moved images and objects will be displayed.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Move source options</strong></td>
<td>Select how the source of moves is displayed. You can select any or a combination of the following formatting options for source moved text: <strong>Bold</strong>, <strong>Italic</strong>, <strong>Underline</strong> and <strong>Strikethrough</strong>. (You cannot select <strong>Underline</strong> and <strong>Strikethrough</strong>.) You also select the font color from the <strong>Color</strong> dropdown list. The source of moved images and objects is indicated with a dashed border in the selected color. An example of how source moved text, source moved images and source moved charts will look with your selections is shown.</td>
</tr>
</tbody>
</table>
### Move destination options

Select how the destination of moves is displayed. You can select any or a combination of the following formatting options for destination moved text: **Bold**, **Italic**, **Underline** and **Strikethrough**. (You cannot select **Underline** and **Strikethrough**.) You also select the font color from the **Color** dropdown list. The destination of moved images and objects is indicated with a dashed border in the selected color. An example of how destination moved text, destination moved images and destination moved charts will look with your selections is shown.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Move destination options</strong></td>
<td>Select how the destination of moves is displayed. You can select any or a combination of the following formatting options for destination moved text: <strong>Bold</strong>, <strong>Italic</strong>, <strong>Underline</strong> and <strong>Strikethrough</strong>. (You cannot select <strong>Underline</strong> and <strong>Strikethrough</strong>.) You also select the font color from the <strong>Color</strong> dropdown list. The destination of moved images and objects is indicated with a dashed border in the selected color. An example of how destination moved text, destination moved images and destination moved charts will look with your selections is shown.</td>
</tr>
</tbody>
</table>

### Property Changes

The **Property Changes** category includes parameters that enable you to specify how items that have had their properties changed will be displayed.

The Property Changes parameters are described in the following table:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Changed item option</strong></td>
<td>Select a color from the <strong>Color</strong> dropdown list. Images and objects that have had their properties changed are indicated with a dashed border in the selected color. An example of how changed images and charts will look with your selection is shown.</td>
</tr>
</tbody>
</table>
**Font Changes**

The **Font Changes** category includes parameters that enable you to specify how text that has had its font changed will be displayed.

The Font Changes parameters are described in the following table:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Changed font option</td>
<td>Select a color from the <strong>Color</strong> dropdown list. Text that has had its font changed is displayed in the selected color. An example of how changed text will look with your selection is shown.</td>
</tr>
</tbody>
</table>
Sensitivity

The Sensitivity category includes parameters that enable you to specify how sensitive Workshare Compare for PowerPoint should be when detecting changes.

![Configuration settings for sensitivity](image)

The Sensitivity parameters are described in the following table:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Slide similarity threshold (%)</td>
<td>Specify at what point insertions and deletions should no longer be marked individually but marked as an entire slide deleted and an entire slide inserted. For example, if you set the threshold at 30% and the similarity between the slides is calculated to be less than 30% then they will be shown as an inserted and deleted slide. If the similarity is calculated as more than 30% then the slides will be shown with changes found to individual items on the slides. Drag the slider to your required setting. As you drag the slider, the percentage is shown as a tool tip above the slider.</td>
</tr>
<tr>
<td>Parameter</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Text Box similarity threshold (%)</strong></td>
<td>Specify at what point insertions and deletions in text boxes should no longer be marked individually but marked as an entire text box deleted and an entire text box inserted. Drag the slider to your required setting. As you drag the slider, the percentage is shown as a tool tip above the slider.</td>
</tr>
<tr>
<td><strong>Table similarity threshold (%)</strong></td>
<td>Specify at what point insertions and deletions in tables should no longer be marked individually but marked as an entire table deleted and an entire table inserted. Drag the slider to your required setting. As you drag the slider, the percentage is shown as a tool tip above the slider.</td>
</tr>
<tr>
<td><strong>Minimum length for moved text</strong></td>
<td>Specify the minimum number of characters to detect as a move – moved pieces of text shorter than this threshold will be shown as an insertion and a deletion. Drag the slider to your required setting. As you drag the slider, the length (in characters) is shown as a tool tip above the slider.</td>
</tr>
<tr>
<td><strong>Threshold for detecting changes in size or position</strong></td>
<td>Specify a threshold which determines how far an object must be moved (or by how much its size must be changed) for the change to be detected. The threshold value is measured in inches. Drag the slider to your required setting. As you drag the slider, the position (in inches) is shown as a tool tip above the slider.</td>
</tr>
<tr>
<td><strong>Minimum ratio of unchanged text to surrounding changes</strong></td>
<td>Specify at what point short matches of text should be ignored if they are surrounded on both sides by unmatched text. This prevents common words such as 'of', 'and' and 'the' being matched up in a paragraph where the content has been completely changed. Drag the slider to your required setting. As you drag the slider, the percentage is shown as a tool tip above the slider.</td>
</tr>
</tbody>
</table>

**Note:** Selecting extreme values for the Sensitivity parameters can lead to unusual comparison results. You can return the Sensitivity parameters to their default settings at any time by clicking **Reset All**.
Appendix C. Configuring Workshare Desktop App

This appendix describes how to configure the Workshare desktop application (the desktop app). This is an application that syncs content between Workshare and your PC so you can access your files and continue collaborating from your desktop while offline.

Configuring the Workshare Desktop App

You can configure application settings for the Workshare desktop app, such as the location of the sync folder or general account settings.

To configure the Workshare desktop app:

1. Click the desktop app system tray icon and select Preferences or from the File menu in the desktop app main window, select Preferences. The following dialog is displayed.

The Account page provides information about your account. You can see your registered Workshare email address that you use to log in to Workshare as well as the address to the Workshare server. Additionally, you have version information about the desktop app.
2. Select **General**.

3. Select the **Launch Workshare when I login** checkbox and the desktop app will start when your computer is started.

4. When you have Workshare 9 (or above) with a DMS integration, select the **Display DMS Open dialog**... checkbox and you can select files from your DMS when uploading files to Workshare from the desktop app.

5. By default, the desktop app uses off-screen rendering (OpenGL rendering). In cases where off-screen rendering is not supported (for example, GPUs with older graphics drivers), the desktop app will automatically switch to on-screen rendering. If the desktop app cannot recognize that there is a problem with off-screen rendering, you can manually switch to on-screen rendering by deselecting the **Enable OpenGL rendering** checkbox.

6. To control how Workshare updates, select from the dropdown:
   - **Automatically download and install updates**: Updates to the desktop app will be downloaded and installed automatically as they become available.
   - **Notify me when updates are ready to install**: You will be notified when updates to the desktop app are available.
7. Select **Network**.

The Network page enables you to limit bandwidth settings and change the settings of your proxy server.

8. In the **Bandwidth** field, click **Change Settings**.

9. If you want to limit the bandwidth available to data downloaded to the desktop app, deselect the **Don't limit** checkbox and specify the limit in the **Limit to** field.

10. Click **Save**.
11. In the **Proxies** field, click **Change Settings**.

   ![Proxy settings](image)

   - **Proxy Settings:**
     - No Proxy
     - Auto-detect
     - Manual:
   - **Force Proxy:**
   - **Proxy Type:**
   - **Server:**
   - **Port:**

12. When working with a proxy server, select **Auto-detect** and Workshare will use your computer’s system settings to connect to the network, or select **Manual** and enter your proxy server details manually.

   **Note:** There is no Auto-detect option available when working on a Mac.

13. When manually specifying proxy server settings, you can select **Force Proxy** so that the desktop app traffic MUST go via your proxy server and if the proxy server is not available then the desktop app will be offline.

14. Select the type of your proxy server (**HTTP**, **HTTP Caching** or **Socks5**) and enter the server address and port number.

15. Click **Save**.
16. Select **Sync Settings**.

![Sync Settings settings](image)

17. If required, change the location of the Workshare sync folder by clicking the browse button and selecting a different location. By default, this folder is named and located as follows:

- **Windows**: C:\Users\[user name]\Workshare
- **Mac**: /Users/[user name]/Workshare

Any files or folders put in this folder will be synced to Workshare online and will appear in the desktop app.
18. Select **Notifications**.

19. If required, change the notification settings. By default, users receive notifications by email and via desktop popup alerts in the following circumstances:
   - When a user first accesses a folder you have shared with them
   - When a new file is added to a shared folder
   - When there is a new version of a file
   - When a comment is posted
   - When someone shares files or folders with you